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KS17C4000 PROGRAMMER'S GUIDE USING THE ARM SDT

USING THE ARM SDT FOR KS17C4000 PROJECTS

This chapter explains how to use the ARM Software Development Toolkit (ARM SDT) to set up a project for
developing and debugging code for the KS17C4000 microcontroller. Information is presented according to the
following Table of Contents:

INEFOAUCTION ... 1-2
KS17C4000 Development ENVIFONMENT.........ccuiiiiiiiiiiiiii 1-3
Building a Demo Project (Windows 95, 98 OF NT) .....ccoiiiiiiiiiiiiiii, 1-4
Using Command Line ToolS to BUIld PrOJECES. ..., 1-6
Debugging and Executing your DemO PrOJECE..........cccvviiiiiiiiiii 1-9
Starting the DebUGOEr ... 1-9
Configuring the DEDUGQET.........ooviiiiii 1-10
Executing the Image File ... 1-11
Stepping through the Program..........ccccciii 1-11
Setting @ Breakpoint ... 1-12
Setting a WatChpOoint ... 1-13
Viewing Variables, Registers, And MEmMOIY .........ccccccciiiiiiiiiiiiii 1-13
Displaying the Code Interleaved with the Disassembly ...........cccooi, 1-13
Communicating with the HOSt USING UART .....uuuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieiiviiveeeebeeeeeeeeeneeeeeeenene 1-14
USIiNg HYPEIErMINal.......cooooeeeeeeeee e 1-14
Hyperterminal Setup for UART CommuNICAtiON.........ccoovviiiieeieeeee e 1-14
Using the KS17C4000 UART with Hyperterminal.............ccoooeeii i, 1-15
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INTRODUCTION

The ARM Software Development Toolkit consists of two applications that let you to write and debug applications
for the KS17C4000 microcontroller, with its embedded ARM7TDMI RISC core:

Project Manager  Lets you write source code, and build the source code into image files or libraries

Debugger Lets you debug your source files.

The ARM SDT is used mainly for software development. This involves building either C or ARM assembler
source code into ARM object code, which can then be debugged using the ARM symbolic debugger. The
debugger software supports single stepping, breakpoint and watchpoint settings, and register viewing. You can
perform testing and debugging on code running under a software emulation in the host system, or on a
KS17C4000 target board system.

The following section reviews the specific SDT components as they relate to KS17C4000 projects, and provides
a brief description of a typical application development work flow.

For complete documentation on the ARM SDT, please refer to the . ARM Software Development Toolkit User $
Guide..
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KS17C4000 DEVELOPMENT ENVIRONMENT

We recommend the following hardware environment for KS17C4000 application development and debugging:

Host computer: An IBM compatible PC running Windows 95, 98 or Windows NT 3.51, with two serial ports
and one parallel port. (One serial port is used to interface with Mult/EmbeddedICE or JEENI. The other serial
port can be used for UART communication, if required.)

Evaluation board: The type of board used depends on the target system.

ICE: To support the debugging interface using the KS17C4000 JTAG controller.

ROM

ICE(Multi’/EmbeddedICE,JEENI) KS17C4000
RAM

EmbeddedICE macrocell

ARM
0 0 \ Core
%_I_Ll Peripheral

Figure 1-1. KS17C4000 Development Environment
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BUILDING A DEMO PROJECT (WINDOWS 95, 98 OR NT)

To build a KS17C4000 demo project, you must perform the following operations using the Project Manager.
(Sample source files for a typical demo project can be found on the KS17C4000 .demo diskette..)

Creating a New Project

1. Select New from the File menu.

2. Choose Project from the New Dialog box.

3. Choose ARM Executable Image as the project type from the list of project templates.

4. Enter the Project Name and Project Directory. The project filename extension .apj is added automatically.
The name of the executable target is the same as the project name. When you have created a new project,
the information in the Project Window is displayed as a hierarchical flow diagram.

In the Project Window, you can select one of two project variants. These variants are automatically constructed
from project templates supplied with the ARM Project Manager:

Debug: for creating a target image that is suitable for debugging, and which includes debugging information.

Release: for creating a target images that is suitable for release, but which includes no debugging
information.

Adding Source Files to the Project
1. Select Add Files to Project from the Project menu.
2. Choose the files you wish to add. The project window is updated to reflect the change.

3. Select Debug as the project variant.

Setting C Compiler Options
1. Select Tool Configuration for <project_name>. apj from the Project menu, and choose <cc>=armcc.
2. Configure the compiler options as follows:

In Target page: [ Processor] | ARM7TM
[ Byte Format] | Big Endian

3. For the remaining options, select the default values.
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Setting Assembler Options

1.

2.

2.

3.

Select Tool Configuration for <project_name>. apj from the Project menu, and choose <asm>=armasm
Configure the assembler options as follows:
Configure the compiler options as follows:

For the Target page: [ Processor] | ARM7TM
[ Byte Format] | Big Endian

For the remaining options, select the default values.

Setting Linker Options

1.

2.

Select Tool Configuration for <project_name>. apj from the Project menu, and choose armlink.
Configure the linker options as follows.
For the Output page: [ Output Formats ] | Absolute AlF
For the Entry and Base page: [ Base of Image ]
<Read-Only> | 0x1000000 (start address of code area)
<Read-Write> | 0x1100000 (start address of data area)
For the Image Layout page: [ Place at start of image ]
<Object File> | Init.o (beginning object file name)
<Area Name> | Init (beginning area name)

For the remaining options, select the default values.

NOTE

For additional options and for descriptions of the compiler, assembler, and linker, please refer to
chapters 1, 2, and 3 of the .ARM Software Development Toolkit Reference Guide..

Building Your Project

When you have added the files you require, and have set up the global options and parameters for specific files,
you are ready to build your project:

1.

Select Build <project_name>. apj .Debug. from the Project menu or click the Build button. The .Force
Build. option lets you rebuild all project files simultaneously.

The current build status is reflected in the Build Log which appears at the bottom of the Project Window
when you build the project.
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USING COMMAND LINE TOOLS TO BUILD PROJECTS

Three activities are required to build a project: compilation, assembly, and linking. You can perform these
activities using the toolkit components, or you can enter the commands directly on the command line:

Compile: armcc < -options > < C source file >
Assemble: armasm < -options > < assembly source file >

Link: armlink < -options > < object files list >

When using the command line to build a project, it is convenient to use the armmake utility. Before you can
execute armmake, you must create a makefile in the working directory. (A sample makefile is included in the
KS17C4000 demo project.)

c:\...\armmake VARIANT=debug debug¢,

Sample Makefile

ARM_I NK= arnl i nk
ARVASM = ar nrasm
ARMCC = arntc

FUNCTI ON_BLOCK = -1D: .\ Function_bl ock

DBA.FLAGS = -ro-base 0x1000000 -rw base 0x1100000 -first Init.o(lnit) -nozeropad \
-d

ROMLFLAGS = -ro-base 0x0 -rw base 0x1100000 -first Init.o(lnit) -nozeropad \
-bi n -nodebug

DWNLFLAGS = -ro-base 0x1000000 -rw base 0x1100000 -first Init.o(lnit) -nozeropad \
-bi n -nodebug

AFLAGS = -apcs /nofp -bi -apcs /noswst -cpu ARWWTM

CFLAGS = -c -fc -apcs 3/32bit/noswst/nofp -bi -processor ARWTM -arch 4T
OBJS = .\$(VARAND\Init.o .\ $( VARI ANT) \ ASM.i b. 0 AS(VARIANT)\ Start.o  \
.\ $( VARI ANT) \ Adc. o .\ $( VAR ANT)\ CLi b. 0 AS(VARIANT)\Btwdt. o\
.\ $( VARI ANT)\ Cache. o .\ $( VARI ANT)\ Dna. o .\'$( VAR ANT)\ | op. 0 \
AS$(VARIANT)\Isr.o A$(VARIANT)\ Si 0. 0 .\ $(VARI ANT) \ Sysmgr. o |\
AS(VARIANT)\Timer.o .\ $(VARI ANT)\ Uart.o .\ $( VARI ANT) \ Test mai n. o\
.\ $( VARI ANT) \ Down. o .\ $(VARI ANT) \ Menory. o .\ $( VARI ANT) \ Exception. o
debug: Ks17c¢4000. axf
Ks17c4000. axf: . \$(VARIANT)\Init.o .\$(VARI ANT)\ ASM.i b.o AS(VARIANT)\ Start. o \
A\ $(VARIANT)\ Adc. o .\ $(VARI ANT)\ CLi b. 0 AS(VARIANT)\Btwdt. o\
.\ $( VARI ANT) \ Cache. o .\ $( VAR ANT)\ Dna. 0 .\'$( VAR ANT)\ | op. 0 \
AS(VARIANT)VIsr.o . \$(VARI ANT)\ Si 0.0 .\ $(VARI ANT) \ Sysmgr. o |\
AS(VARIANT)\Timer.o .\ $(VARI ANT)\ Uart. o .\ $( VARI ANT) \ Test mai n. o\

A $(VARIANT)\ Down. o .\ $(VARI ANT)\ Menory. o .\ $( VARI ANT) \ Exception. o
$(ARMLI NK) $(DBGLFLAGS) -0 .\ $(VARI ANT)\ Ks17c4000. axf $(OBJIS)
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downl oad: Ks17c4000. dwn

Ks17c4000. dwn: . \$(VARIANT)\Init.o .\$(VARI ANT)\ ASM.i b.o AS(VARIANT)\ Start. o \
A\$(VARI ANT)\ Adc.o .\ $( VAR ANT)\ CLi b. o A$(VARIANT)\Btwdt. o\
.\ $( VARl ANT)\ Cache. o .\ $( VAR ANT)\ Dna. o \$(VAR ANT)\ | op. 0 \
AS(VARIANT)VIsr.o . \$(VARI ANT)\ Si 0.0 .\ $(VARI ANT)\ Sysmgr. o |\
AS(VARIANT)\Timer.o . \$(VARI ANT)\ Uart. o .\ $( VARI ANT) \ Test mai n. o\

.\ $(VARI ANT)\ Down. 0 .\ $( VARI ANT)\ Menory. o\

.\ $( VARI ANT) \ Exception. o
$(ARMLI NK) $(DWNLFLAGS) -0 .\ $( VAR ANT)\ Ks17c4000. dwn $( OBIS)
sftp 1 .\$(VAR ANT)\ ks17c4000. dwn

rom Ks17c4000.rom

Ks17c4000.rom .\$(VARIAND)\Init.o .\$(VARI ANT)\ ASM.i b.o AS(VARIANT)\ Start. o \
\$(VARI ANT)\ Adc.o .\ $(VAR ANT)\ CLi b. o A$(VARIANT)\Btwdt. o\
.\ $( VARl ANT)\ Cache. o .\ $( VAR ANT)\ Dna. o .\ $( VAR ANT)\ | op. 0 \
AS(VARIANT)VIsr.o . \$(VARI ANT)\ Si 0.0 .\ $(VARI ANT) \ Sysmgr. o |\
AS(VARIANT)\Timer.o .\ $(VARI ANT)\ Uart. o .\ $( VARI ANT) \ Test mai n. o\

A $(VARIANT)\ Down. o .\ $(VARI ANT)\ Menory. o .\ $( VARI ANT) \ Exception.o
$( ARMLI NK) $( ROMLFLAGS) -0 .\ $( VAR ANT)\ Ks17c4000. r om $( OBJS)
copy .\$(VARI ANT)\ ks17c4000.rom .\ $( VARI ANT)\ 40. rom
split2 .\$(VARI ANT)\40.rom .\$(VARI ANT)\evn .\$(VARI ANT)\ odd
bi n2hex .\ $( VAR ANT)\evn .\ $(VARI ANT)\evn.hex 0 0 O
bi n2hex .\ $(VARI ANT)\ odd .\ $(VARI ANT)\ odd. hex 0 0 O
Del .\ $(VARI ANT)\ 40. *

.\ $(VARI ANT)\ CLi b.0: .\CLib.c
$(ARMCC) $( CFLAGS) .\CLib.c -0 .\$(VAR ANT)\ CLi b. o \
$( FUNCTI ON_BLOCK)

.\ $(VARI ANT)\ Adc. o: .\ Function_bl ock\ Adc. c
$(ARMCC) $(CFLAGS) .\Function_block\Adc.c -0 .\$(VARI ANT)\ Adc. o \
$( FUNCTI ON_BLOCK)

AV $(VARI ANT)\ Bt wdt . 0: .\ Functi on_bl ock\ Bt wdt . c
$(ARMCC) $(CFLAGS) .\Function_block\Btwdt.c -o .\ $(VARI ANT)\ Bt wdt. o \
$( FUNCTI ON_BLOCK)

.\ $(VARI ANT) \ Cache. o: .\Function_bl ock\ Cache. c
$(ARMCC) $(CFLAGS) .\Function_bl ock\ Cache.c -0 .\$(VARI ANT)\ Cache. o \
$( FUNCTI ON_BLOCK)

.\ $(VARI ANT)\ Dra.. 0: .\ Functi on_bl ock\ Dma. c
$(ARMCC) $(CFLAGS) .\Function_block\Dma.c -0 .\$(VARI ANT)\ Dma. o \
$( FUNCTI ON_BLOCK)

.\ $( VARI ANT) \ Down. o: .\ Functi on_bl ock\ Down. c
$(ARMCC) $(CFLAGS) .\ Function_bl ock\Down.c -0 .\$(VARI ANT)\ Down. o \
$( FUNCTI ON_BLOCK)

A $(VARIANT)\ | op. 0: .\ Function_bl ock\lop.c
$(ARMCC) $(CFLAGS) .\Function_block\lop.c -0 .\$(VARIANT)\lop.o \
$( FUNCTI ON_BLOCK)
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A$(VARIANT)\ I sr.o: .\Function_block\lsr.c
$(ARMCC) $(CFLAGS) .\Function_block\lIsr.c -0 .\$(VARIANT)\Isr.o \
$( FUNCTI ON_BLOCK)

.\ $(VARI ANT) \ Test nai n. o: .\ Functi on_bl ock\ Mai n. c
$(ARMCC) $(CFLAGS) .\Function_block\Main.c -o .\$(VARI ANT)\ Test mai n. 0 \
$( FUNCTI ON_BLOCK)

.\ $(VARI ANT)\ Menory. o: .\ Functi on_bl ock\ Menory. c
$(ARMCC) $(CFLAGS) .\Function_block\Menory.c -o .\$(VARI ANT)\ Menory. o \
$( FUNCTI ON_BLOCK)

\A$(VARIANT)\ Si 0. 0: .\ Function_bl ock\Sio.c
$(ARMCC) $(CFLAGS) .\Function_block\Sio.c -0 .\$(VARIANT)\Si 0.0 \
$( FUNCTI ON_BLOCK)

AS(VARIANT)\ Start.o: .\Function_block\Start.s
$(ARVASM) $(AFLAGS) .\Function_block\Start.s -o .\$(VARIANT)\ Start.o \
$( FUNCTI ON_BLOCK)

.\ $(VARI ANT)\ Sysmgr. o: .\ Functi on_bl ock\ Sysmmgr. c
$(ARMCC) $(CFLAGS) .\Function_bl ock\Sysmmgr.c -o .\$(VARI ANT)\ Sysmmgr. o \
$( FUNCTI ON_BLOCK)

AS(VARIANT) A Timer. o: .\ Function_bl ock\Tiner.c
$(ARMCC) $(CFLAGS) .\Function_block\Tiner.c -o .\$(VARIANT)\ Tinmer.o \
$( FUNCTI ON_BLOCK)

A $(VARIANT)\ Uart.o: .\Function_bl ock\Uart.c
$(ARMCC) $(CFLAGS) .\Function_block\Uart.c -o .\$(VARIANT)\ Uart.o \
$( FUNCTI ON_BLOCK)

.\ $(VARI ANT) \ Exception. o: .\Exception.c
$(ARMCC) $(CFLAGS) .\Exception.c -o .\$(VARI ANT)\ Exception.o \
$( FUNCTI ON_BLOCK)

AS(VARIANT) VI nit.o: .\lnit.s
$(ARMASM) $(AFLAGS) Init.s -0 .\$(VARIANT)\ I nit.o $(FUNCTI ON_BLOCK)

.\ $( VARI ANT)\ ASM.i b. 0: .\ ASM.i b. s
$(ARMASM) $(AFLAGS) ASMLib.s -0 .\$(VARI ANT)\ ASM.i b. o $( FUNCTI ON_BLOCK)

cl ean:
del .\$(VARI ANT)\*, *
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DEBUGGING AND EXECUTING YOUR DEMO PROJECT

When you build a project, the Project Manager creates a new subdirectory called ‘Debug’ or ‘Release,” depending
on the variant you select. This subdirectory is located below the current working directory. Several object files are
placed in this variant subdirectory. The executable ARM image code, <project_name>.axf, is also generated in
this subdirectory.

If you are using the ARM Project Manager, you can then start the ARM Debugger for Windows and load the
image of the application you are developing. This procedure is described below.

STARTING THE DEBUGGER
There are two ways to start the debugger and load the executable image:
Using the ARM Project Manager

Click the Debug button of the Project Manager to open the ARM Debugger For Windows. The Debugger
loads your project image automatically and breaks at the first line of the code.

Not using the ARM Project Manager

1. Execute the ARM Debugger For Windows. (This software is included in the ARM Windows Toolkit 2.11a.
program group).

2. Choose Load Image from the File menu or click the Open File button to select the ARM Image file
(project_name.axf) you want to load.
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CONFIGURING THE DEBUGGER

1. Select Configure Debugger from the Options menu. The Debugger Configuration dialog box is
displayed. There are two Target Environments, as follows.

ARMulator: Lets you execute ARM programs without physical ARM hardware by simulating ARM instructions
in software.

Remote_A: Connects the ARM debugger directly to a target board or to an EmbeddedICE unit that is
attached to a target board.

NOTE

Please note the following requirements for using Remote_A: 1) a direct target board connection requires
Angel debug monitor software, 2) the EmbeddedICE software must be version 2.0 or greater, and 3)
application programs must be linked using the SDT 2.1 C language library.

Select the appropriate variants for your application, and click the Configure button. The ARMulator
Configuration or Angel Remote Configuration dialog box is displayed.

2. For ARMulator configuration, set the Processor Variant to ARM7TDMI and the Processor Clock Speed to
33.00 MHz or other frequency. For Angel Remote Configuration, set the Remote Connection type, Ports,
and Serial Line Speed to the proper values for your system environment.

3. Select the Debugger page and set the Endian value to Big.

4. Click OK. If you are using Remote_A, the image file is downloaded to the DRAM or SRAM.
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EXECUTING THE IMAGE FILE

1.

Initialize system variables. After a download, several windows are displayed such as the Execution window,
Console window, and the Command window. In the Command window, you must initialize the system
variables, $semihosting_enabled and $vector_catch, by entering the following commands.

| et $vector_catch = 0x00
| et $sem hosting enabl ed = 0x00

Or, you can initialize these variables in the following way:

First, create a text file called .armsd.ini., that includes the above commands. Then, enter the following
command in the command window:

ob c:\arnRlla\arnsd.ini
The “armsd.ini” file is found in “ C:\...\Demodisk\armutil\" folder.

For more information about this step, please refer to chapter 6 of the ARM Software Development Toolkit
User Guide”.

Execute the program. To do this, select Go from Execute menu, or click the Go button. When you do this,
program execution starts. When you execute the image, the program is displayed in the Execution window as
source. The program halts at any breakpoints or watchpoints you have applied.

STEPPING THROUGH THE PROGRAM

To step through the program execution flow, you can select from the following three options:

Step: Advances the program to the next line of code that is displayed in the Execution window.

Step Into: Advances the program to the next line of code that follows all function calls. If the code is in a
called function, the function source is displayed in the Execution window and the current code line is
highlighted.

Step Out: Advances the program from the current function to the point from which it was called immediately
after the function call. The appropriate line of code is displayed in the Execution window.
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SETTING A BREAKPOINT

A breakpoint is a point you set in program code where the ARM debugger will halt program execution. When you
set a breakpoint, it appears as a red marker in the left side of the window.

To set a simple breakpoint on a line of code, follow these steps:

1. Double-click on the line where you want to place the break, or choose Toggle Breakpoint from the Execute
menu. The Set or Edit Breakpoint dialog box appears.

2. Set the count to the required value or expression, as required. (The program only halts when this expression
is true.)

To set a breakpoint on a line of code within a particular program function:
1. Display a list of function names by selecting Function Names from the View menu.

2. Double-click on the Function Name you wish to open. A new source window is displayed containing the
function source.

3. Double-click on the line where the breakpoint is to be placed, or choose Toggle Breakpoint from the
Execute menu. The Set or Edit Breakpoint dialog box appears.

4. Set the count to the required value or expression, as required. (The program only halts when this expression
is true.)
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SETTING A WATCHPOINT
A watchpoint halts a program when a specified register or variable changes or becomes a specified value.
To set a watchpoint, follow these steps:

1. Display a list of registers, variables, and memory locations you wish to watch, by selecting the Registers,
Variables, and Memory options from the View menu.

2. Click the register, variable, or memory area in which you wish to set the watchpoint. Then choose Set or Edit
Watchpoint from the Execute menu or the Context menu. The Set or Edit Watchpoint dialog box
appears.

3. Enter a Target Value in the Set or Edit Watchpoint dialog box. Program execution halts when the variable
reaches the specified target value.

VIEWING VARIABLES, REGISTERS, AND MEMORY

You can view and edit the value of variables, registers, and memory by choosing the respective heading from the
View menu, as follows:

Variables for global and local variables.
Registers for the current mode and for each of the six register view modes.
Memory for the memory area defined by the address you enter.

DISPLAYING THE CODE INTERLEAVED WITH THE DISASSEMBLY

To display the source code interleaved with the disassembly, choose Toggle Interleaving on the Options menu
or the Context menu. This command toggles between Displaying source only and Displaying source interleaved
with disassembly. When source code is shown interleaved with disassembly, machine instructions appear in a
lighter gray color.

For additional information about the ARM Debugger, please refer to Chapter 3 of the ARM Software
Development Toolkit User $ Guide..
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COMMUNICATING WITH THE HOST USING UART

When debugging or executing a program, it is useful to monitor communications between the KS17C4000 MCU
and the host. Using UART and a communication terminal program, you can view data or messages that are
transferred from KS17C4000 and you can transmit data or a command to KS17C4000.

Using the HyperTerminal program that is supported by Windows 95/98, the host can communicate with the
KS17C4000’s UART module. (You can also use other communication terminal programs.) Guidelines for using
the HyperTerminal and UART functions are described below.

USING HyperTerminal

To start the HyperTerminal program (on Windows 95/98):

1. Select the Start | Programs | Accessories | HyperTerminal group.

2. Double click on Hypertrm.exe, enter the Connection Name, and select the Icon. Click on OK.

3. Inthe Phone Number dialog box, choose Direct to COM1 or COM2 as the Connect Using setting from the
list of communication port templates for your system environment. Click on OK. The COM1 or COM2
Properties dialog box is displayed.

4. Set Bits per Second to its proper value. (38400bps)

5. Set Stop Bits to 1 Stop bit, Data Bits to 8 bit and Parity to none, Flow control to none. The other properties
should be set to their default value.

You have now created a new empty terminal that is connected to the specified serial port. The terminal window is
displayed.

HyperTerminal SETUP FOR UART COMMUNICATION
Follow these steps to set up the HyperTerminal software for UART communication with the KS17C4000:
1. Select Properties from the File menu.
2. When the <Connection_Name> Properties window is displayed, choose the Setting page.
3. Click the ASCII Setup button, and select the following check menus:
ASCII Sending Echo Typed Characters Locally.

ASCIl Receiving Append Line Feed to Incoming Line End.
Wrap Lines That Exceed Terminal Width.
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USING THE KS17C4000 UART WITH HyperTerminal

For information about how to set up the UART, please refer to the flowcharts and sample source code in Chapter
6 this manual. To send and receive messages to/from the host using the KS17C4000 UART, follow these steps:

Sending a Message to the Host

When you have properly set up the UART, you can send a message to the host by entering the following
command:

Put _string(. Hello!l... \r );

NOTE

If your host uses HyperTerminal, use the code \r instead of \n in the C program. Also, the ‘Put_string'
function is described in Chapter 6.

Receiving a Message from the Host
To receive a message from the host, enter the following command:

nessage = get _char();

The ‘get_char’ function is described in Chapter 6 of this manual.

ELECTRONICS PRELIMINARY VERSION 1.0 1-15



USING THE ARM SDT KS17C4000 PROGRAMMER'S GUIDE

Notes
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INTERLEAVING C AND ASSEMBLY CODE

This chapter explains the concept of combining (interleaving) C code and ARM assembly code in a single
executable program and illustrates this concept with several sample programs. Information is presented
according to the following Table of Contents:

INEFOAUCTION ... 2-2
APCS (Arm Procedure Call Standard)............ccccoviiiiiiiiiii 2-3
Register Names and Usage for APCS........oooiiiiiii 2-4
Passing and ReturNiNg ArQUIMENTS ........coiiiiiiiiiiiiiiii e 2-5
EXAMPIE COUC ....coiiiiiiiiiiiiiiii 2-6
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INTRODUCTION

In some situations, it is necessary to combine C language code and assembly code in the same program. Some
routines that are especially critical to system performance must, for example, be hand-coded in order to run at

optimum speed.

Using the appropriate tools, you can generate an object file in both C and assembly language source code. To do
this, you use the ARM C Compiler and the ARM Assembler, respectively. You then link the generated sources
with one or more libraries to produce an executable file, as shown in Figure 2-1.

Assembly Source > armasm
codes
_ ARM
C Library > armlink —| Image
A Code
C Source Codes —> armcc

Figure 2-1. Interleaving C and Assembly Language Source Code

Regardless of which language a routine is written in, routines that make cross-calls to other modules must
observe standard conventions for passing arguments and results. For ARM processors, this convention is called
the ARM Procedure Call Standard, or APCS. In this chapter, we briefly introduce APCS and discuss its role for
passing and returning values in ARM assembly language and C routines.
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APCS (ARM PROCEDURE CALL STANDARD)

The ARM Procedure Call Standard, or APCS, is a set of rules which governs calls between functions in
separately compiled or assembled code fragments. The APCS defines:

Constraints on the use of registers

Stack conventions

The format of a stack back-trace data structure
Argument passing and result returns

Support for the ARM shared library mechanism

The APCS standard consists of a family of variants. Each variant is exclusive, so that code which conforms to
one variant cannot be used with a code defined for another variant. Your choice of variant depends on the
following criteria:

Whether stack limit checking is explicit (performed by code) or implicit (performed by memory management
hardware).

Whether floating-point values are passed to floating-point registers.

Whether code is reentrant or non-reentrant.

For the complete APCS specification, see Chapter 5 of . The ARM Software Development Toolkit Reference
Guide..
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REGISTER NAMES AND USAGE FOR APCS

The following table summarizes the names and uses of ARM and floating-point registers under APCS.

Table 2-1. Register Names and Uses Under APCS

Register APCS APCS
Number Name Function
ro al argument 1 / integer result / scratch register
rl a2 argument 2 / scratch register
r2 a3 argument 3 / scratch register
r3 a4 argument 4 / scratch register
r4 vl register variable
r5 v2 register variable
ré v3 register variable
r7 v4 register variable
rg v5 register variable
ro sb/v6 static base / register variable
rio sl/v7 stack limit / stack chunk handle / register variable
ril fp frame pointer
ri2 ip scratch register / new-sb in interlink unit calls
ri3 sp lower end of current stack frame
ri4 Ir link address / scratch register
ris pc program counter

To summarize:

al-a4 are used to pass arguments to functions. al is also used to return integer results. These registers can

be corrupted by a called function.

v1-v5 are used as register variables. They must be preserved by called functions.

sb, sl, fp, ip, sp, Ir, pc sometimes have a dedicated role in an APCS variant. In other words, some of these
registers can be used for other purposes while also strictly conforming to APCS standard. In some APCS

variants, sb and sl are available as additional variable registers to v6 and v7, respectively.

For a detailed description of each register, please refer to chapter 5 of . The ARM Software Development Toolkit
Reference Guide..
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INTERLEAVING C AND ASSEMBLY CODE

PASSING AND RETURNING ARGUMENTS

As noted above, passing and returning arguments use the argument registers al-a4. (These are the APCS

names for registers r0-r3, respectively. Using these registers, you can transfer up to four arguments directly (that

is, not using stack area). The arguments can be a mixture of C and assembly language code. Of course, if the

number of passed arguments exceeds four, you must use stack area. As shown in Figure 2-2, the callee returns
the result to the C function through register al.

Return Result
l al
a2
C Function T Ag£4 g a3 ) "|  Assembler Function
3 — a4 «—
,| Stack |
arg > 4 Area
Figure 2-2. Passing and Returning Arguments
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EXAMPLE CODE
The following two program samples include C and assembly code versions:
EXAMPLE A
Given, the number of passed parameters is £ 4.
C code: Call the assembly function to add four integer arguments and return the result value.

int ReturnVal;
Returnval = Add_ASM (0, 5, 10, 15)

Assembly code: Add four integer arguments and return the result value.

EXPORT Add_ASM ; Declare Add_ASM as extern function
Add_ASM
ADD al, al, a2 ; al =0, a2 =5, a3 = 10, a4 = 15
ADD al, al, a3
ADD al, al, a4 ; al = return value (= 30)
MOV pc, Ir
EXAMPLE B

Given, the number of passed parameters is > 4.
C code: Call the assembly function to add six integer arguments and return the result value.

i nt ReturnVal;
Returnval = Add_ASM (0, 5, 10, 15, 20, 25)

Assembly code: Add six integer arguments and return the result value.

EXPORT Add_ASM ; Declare Add_ASM as extern function
Add_ASM

ADD al, al, a2 ; al =0, a2 =5, a3 = 10, a4 = 15

ADD al, al, a3

ADD al, al, a4

LDR vl, [sp, #4] ; vl = 20 (load paraneter val ue from stack)

ADD al, al, vl

LDR vl, [sp, #8] ;o vl = 25

ADD al, al, vi ; al = Return value (=75)

MOV pc, Ir
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EXCEPTION HANDLING

This chapter explains how exceptions are handled. It also tells you how to set up an exception vector table and
how to write an exception handler routine. Information is presented according to the following Table of Contents:

INEFOAUCTION ... 3-2
EXCeption HandIiNgG .......oooiiiiiiiiiiiii 3-3
The EXception VECIOr TabIe .........cooiiiiice e 3-3
ENtering an EXCEPLION .....coivieiiiiiieeii ettt 34
Leaving an EXCEPLION ....cccoe oo 3-5
Sample EXCeption HANAIET ...........cccuiiiiiiiiioii e 3-5

Installing an Exception Handler
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INTRODUCTION

An exceptions occurs when the normal flow of execution through a user program is diverted to allow the
processor to handle events generated by internal or external sources. Two examples of such events are:

Externally-generated interrupts

An attempt by the processor to execute an undefined instruction

When handling exceptions, the previous processor status must be preserved so that the execution of the original
user program can resume immediately after the appropriate execution routine is completed.

The ARM processor recognizes seven types of exceptions:

Reset Occurs when the CPU reset pin or the overflow of watch-dog timer is asserted. This
exception normally occurs to signal a power-up, or to initiate a reset following CPU
power-up. It is therefore useful for initiating a .soft. reset.

Undefined Instruction  Occurs if neither the CPU nor any attached coprocessor recognizes the instruction
currently being executed.

Software Interrupt A user-defined synchronous interrupt instruction which allows a program running in User
mode to request privileged operations that run in Supervisor mode.

Pre-fetch Abort Occurs when the CPU attempts to execute an instruction which has been pre-fetched
from an illegal address. In this case, an illegal address is an address that the memory
management subsystem has determined is inaccessible to the CPU in its current mode.

Data Abort Occurs when a data transfer instruction attempts to load or store data at an illegal
address.
IRQ Occurs when the CPU'’s external interrupt request pin is asserted (Low) and the | bit in

the CPSR is clear.

FIQ Occurs when the CPU'’s external fast interrupt request pin is asserted (Low) and the F bit
in the CPSR is clear.
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EXCEPTION HANDLING

THE EXCEPTION VECTOR TABLE

The ARM processor supports seven types of exceptions. Each type is assigned a privileged processor mode.
When an exception occurs, program execution is forced from a fixed memory address corresponding to the
exception type. These fixed addresses are called .hard vectors..

Exception handling is controlled by a vector table. The vector table is a reserved 32-byte area at the bottom of
the memory map with one word of space allocated to each exception type. Because there is not enough space to
contain the complete code for an exception handler, the vector entry for each exception type typically contains a
branch or load PC instruction that passes control to the appropriate handler routine.

Table 3-1 lists the exception types, the corresponding processor modes, and the .hard. vector addresses for each
type.

Table 3-1. Exception Processing Modes and Vectors

Exception Type Mode Vector Address
Reset SvVC 0x00000000
Undefined Instruction UNDEF 0x00000004
Software Interrupt (SWI) SvC 0x00000008
Pre-fetch Abort ABORT 0x0000000c
Data Abort ABORT 0x00000010
IRQ IRQ 0x00000018
FIQ FIQ 0x0000001c

ELECTRONICS PRELIMINARY VERSION 1.0 3-3



EXCEPTION HANDLING KS17C4000 PROGRAMMER'S GUIDE

ENTERING AN EXCEPTION

When an exception is generated, the processor executes the following steps. (Again, these operations are
performed by the processor, not by a user program):

1.

SPSR_<exception_mode> := CPSR

Copies the contents of the Current Status Register (CPSR) into the Saved Program Status Register (SPSR)
of the mode in which the execution is to be handled. This saves the current mode, interrupt masks, and
condition flags.

LR_<exception_mode>:=PC -4
Stores the return address (pc-4) in Ir_<exception_mode>.
PC := Vector address_ <exception_mode>

Sets the PC to the appropriate vector address. That is, execution control is forced to an exception handler
whose entry address is hard-wired to the lower memory area.

The processor then sets the appropriate CPSR mode bits:

CPSR[5:0] := Exception mode number

To change to the appropriate mode, also mapping in the appropriate banked registers for that mode.
CPSR[6] := 1 (if the exception mode is RESET or FIQ), or

CPSR[7] := 1 (to disable interrupts)

Note that IRQs are disabled when any other type of exception occurs and FIQs are disabled whenever an
FIQ exception occurs.

3-4
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LEAVING AN EXCEPTION

To return control of program execution to the place where the exception occurred, the handler must perform the
following steps. (These steps must be performed by a user program):

1. CPSR :=SPSR_<exception_mode>

2. PC:=LR _<exception_mode>

The handler performs these two operations as an atomic instruction by performing a data processing instruction
with the S flag set, and with the PC as the destination register:

MOVS pc, Ir

Each exception type requires the use of a different instruction. The actual value that is stored in the PC is also
dependent on the exception type, as follows:

Undefined Instruction MOVS pc, Ir
S MOVS pc, Ir
Pre-fetch Abort SUBS pc, Ir, #4
Data Abort SUBS pc, Ir, #8
IRQ SUBS pc, lr, #4
FIQ SUBS pc, lr, #4

SAMPLE EXCEPTION HANDLER

The basic form of an exception handler is as follows:

Def aul t _Handl eExcepti on
<Save val ue of registers to the stack area>
<Exception service routine perforned by user application>
<Restore the values in the stack area to the corresponding registers>
<Return the PC val ue according to exception type>
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INSTALLING AN EXCEPTION HANDLER

You must install any new exception handler in the vector table. Once the installation is complete, the new handler
executes wherever the corresponding exception occurs.

Installing the Handlers at Reset

Exception handlers can be included in a boot program or they can be standalone programs. Boot programs are
used to initialize the system environment for application development. Standalone programs, on the other hand,
do not rely on the debugger or debug monitor to start program execution. This makes it possible to load the
vector table directly as part of your assembler reset (or startup) code. If your ROM area starts at memory location
0x0, you can use a simple branch statement for each vector at the start of your program.

Example Handler Installation Routine

KS17C4000 boot ROM programs and standalone ROM programs must include an exception installation routine
as part of the startup code. In the example below, only the program block related to FIQ exception handling is
shown. For more information and examples about boot ROM programs, see Chapter 7 of this manual.

/1 [ header file : Menory.a ]

R e G /1
; Align Exception Handler Area...for 8 exception sources...

7 ( Ox11fff00 ~ Ox11fff20 )

; RAM Exeption Handl e Tabl e

n 0x11f ff 00
Handl eReset # 4 ;0x1f _ff0o0 -ff03
Handl eUndef # 4 ;0x1f _ff04
Handl eSwi # 4 ; 0x1f _ff08
Handl ePr ef et ch # 4 ; 0x1f _ffOc
Handl eAbort # 4 ;0x1f _ff10
Handl eReserv # 4 ;0x1f _ff14
Handl el rq # 4 ;0x1f _ff18
Handl eFi g # 4 ;0x1f _fflc -ffle
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v
;11 [ KS17C4000 Boot Program: Init.s ]
v

GET MEMORY. A
GET KS17C4000. A

AREA Init, CODE, READONLY
ENTRY

; [ Setup interrupt / exception vectors ]
: Booting from address 0O

Reset Handl er ; Start Address ( hardwi red vector = 0x0 )
Undef i ned_Handl er
SW _Handl er
Pref et ch_Handl er
Abort Handl er
. ; Reserved
| RQ_Handl er
FI Q Handl er ; Remakrk to save FIQ access tine...
; So, Address of l|abel "FIQ Handler is Oxlc

W WWWwWwWwm

; [ The Default Exception Handler Vector Entry Pointer Setup ]

; Fetch the handler entry address fromthe exception handler table, |ocated
; in DRAM |l ocation Ox to Ox , and then deliver the address tor the "PC'
; in order to pass control to the correspondi ng excepti on handl er

FI Q_Handl er
SUB sp, sp, #4
STMFD sp!, {ro0}
LDR r0, =Handl eFiq
LDR ro, [rO0]
STR ro, [sp, #4]
LDVFD sp!, {r0, pc} ; Branch to real FIQ handler routine on DRAM

; Junp to [Handl eFi q]

; Address, Handl eFiq hold the final nestination address for FIQ interrupt handl er
; In this code, the contents of Handl eFi g hold Fi gHandl er address.

; That is, [HandleFiq] = [pl SR FIQ = #FigHandl er => [Ox11ffflc] = #Fi gHandl er

| RQ_Handl er
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1

/1 [ header File: Exception.h ]

1

#i f ndef _EXCEPTI ON_H_

#define _EXCEPTION_H_

#define _| SR _STARTADDRESS 0x11f ff 00

/1 KS17C4000 Exception Handl er Tabl e

#def i
#def i
#def i
#def i
#def i
#def i
#def i
#def i

ne
ne
ne
ne
ne
ne
ne
ne

#endi f

pl SR_RESET (*(unsi gned
pl SR_UNDEF (*(unsi gned
pl SR_SW (*(unsi gned
pl SR_PABORT (*(unsi gned
pl SR_DABORT (*(unsi gned
pl SR_ RESERVED  (*(unsi gned
pl SR I RQ (*(unsi gned
pl SR_FI Q (*(unsi gned

/1 _EXCEPTION H_

*) (_I SR_STARTADDRESS+0x0) )
*) (_I SR_STARTADDRESS+0x4) )
*) (_I SR_STARTADDRESS+0x8) )
*) (_I SR_STARTADDRESS+0xC) )
*) (_I SR_STARTADDRESS+0x10) )
*) (_I SR_STARTADDRESS+0x14) )
*) (_I SR_STARTADDRESS+0x18) )
*) (_I SR_STARTADDRESS+0x1c))
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EXCEPTION HANDLING

/1 [ header File: Exception.c ]

/1 [ Default Exception Handl er Routine ]

void __irg HaltUndef(void){ Print("\rUndefined Instruction");

void _irg HaltSw (void){ Print("SW exception!!!\n");
void __irq FigHandl er(void)
{
unsi gned i nt |ntRegVal ue;
unsi gned char i;
I nt RegVal ue = rI NTPEND & ~r | NTMODE & r| NTMASK ;
for(i=0; (IntRegValue) && (i<32); i++)
{
if( IntRegvalue & 1)
{
Cl ear PendingBit(i); /1 Interrupt Acknow edge,
(*InterruptHandlers[i])(); // Junp to appropriate Interrupt
/] service routine.
}
I nt RegVal ue >>= 1;
}
}
| ® o o e e e e e e e e e e e e e e eeeeiaoos
| Functi on . void I nitExceptions(void)
| Description : Initialize for Exception handle
*

void I nitExceptions(void)

{
pl SR_UNDEF =(unsi gned) Hal t Undef ;
pl SR_SW =(unsi gned) Hal t Swi ;
pl SR_PABORT =(unsi gned) Hal t Pabort ;
pl SR_DABORT =(unsi gned) Hal t Dabort ;
pl SR I RQ =(unsi gned) | r gHandl er;
pl SR FI Q =(unsi gned) Fi gHandl er;
}

while(1l);

while(1l);

pending bit.
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Notes
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MEMORY MANAGEMENT

This chapter describes the default KS17C4000 memory map and explains how to write programs to allocate
memory areas. Information is presented according to the following Table of Contents:

INEFOAUCTION ... 4-2
KS17C4000 MEMOTY MAP ....ciieeiieiiie ettt ettt e et e e e e 4-3
MEMOTY MAPPEU ATCBS.......iiiiiiiiiiiiiiiiee 4-4
SPECIAl REGISIEIS ... 4-4
DR A e 4-4
RO 4-4
Example Code for Memory Area Definition ...........ccccccoiii 4-5
Y 0 To 10 | A 111 00PN 4-6
Example Code for <INIE.S> ... 4-7
MEMOIY ANIOCALION ..cevviiiiiiiiiiiiiiii 4-8
Using malloc( ) with the KSL17CA000 ......ccoooviiiieieeeeeeeee e 4-9
Example Code Using the malloc( ) FUNCHON .........coooooiiiiii, 4-10
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INTRODUCTION

The KS17C4000 MCU uses its System Manager block to manage memory. Specifically, the System Manager
uses special registers to manage the control signals, addresses, and data that are required by external devices.

To control external memory operations, the System Manager uses programmed settings in a dedicated set of
special registers. You can, for example, specify the memory type, the external data bus width for each bank, and
the number of access cycles for each memory bank. You can also define the memory map by specifying bank
locations and sizes that correspond to address spacing assignments.

Using these special registers, you can configure up to four banks; ROM / SRAM / DRAM bank in a 32-Mbyte
addressable system space. The ordering of these banks with the system space is arbitrary.

For more information about the System Manager, please refer to Chapter 6 of this manual, or to the . KS17C4000
16-Bit RISC Microcontroller User $ Manual..
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KS17C4000 MEMORY MAP

Figure 4-1 shows a typical memory map for a boot ROM program written for the KS17C4000 evaluation board.

More information about each area of the memory map is provided below.

OXLFF_0000

0x130_0000

0x128_0000

0x120_0000

0x100_0000

0x002_0000

0x000_0000

System Space

Special Registers

Not Used

X8 SRAM

X16 SRAM

DRAM (2 MB)

Not Used

ROMO (128 KB)

DRAM Configuration

Reserved

Exception Handler Vector Table

Mode Stack Area

Data Area (1 MB)

Code Area (1 MB)

0x120_0000

Ox11F_FF20

0x11F_FF00

0x11F_E700

0x110_0000

0x100_0000

Figure 4-1. KS17C4000 Memory Map
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MEMORY MAPPED AREAS

SPECIAL REGISTERS

The boot ROM program defines and initializes each function block according to specified values. The special
register area definition is controlled by the base address in the SYSCFG register, which indicates the start
address of the special registers. The start address of individual special registers is defined as the base address
(SYSCFG value) + the register offset value.

DRAM

The DRAM area contains a R/W (read/write) area, a R/O (read-only) area, and several user-defined areas, as
follows:

The exception handler vector table contains an exception handler vector address for each of the eight
exception sources.

The mode stack area is used to allocate stack area for each of the six operating modes.

The data area is used for global variables. Memory in this space can be freely allocated or released by the
user application.

The code area contains executable code which the user downloads from the host. This area is therefore
meaningful only for program debugging.

ROM

The ROM area contains executable code and read-only data. You can use the ROM area for a boot ROM
program that initializes the system environment for application development, as well as for standalone ROM code
that contains complete execution codes and data.
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EXAMPLE CODE FOR MEMORY AREA DEFINITION

All of the user-definable memory areas can be configured by the user program, except for the code and data
areas, which are defined by linker option. Several examples are provided below.

Define Data and Code Area Using the ar nl i nk Command or Windows Toolkit

armlink <...... > -Base 0x1000000 -Data 0x1100000 <........ >

Set Up the Special Register Area Using Ox1FF_0000 as Special Register Base Address

[ dr ro, =0x1FF1000 ; Default address of SYSCFG = Ox1FF_1000
[ dr ri, =0x1FFO ; Base address = Ox1FF0000
str ri, [rO]

Define a Top-Down Stack Area at Locations Ox11FE700-0x11FFF00

User St ack EQU 0x11f eb00 ; OxX??27?27?7~0x11f eaf f

Undef St ack EQU Ox11f ef 00 ; Ox11f eb00~0x11f eef f (1024Byt e)
Abor t St ack EQU Ox11ff 300 ; Ox11f ef 00~0Ox11f f 2f f (1024Byt e)
I rgqSt ack EQU Ox11ff 700 ; Ox11f f 300~0x11f f 6f f (1024Byt e)
Fi qSt ack EQU Ox11ff b00 ; Ox11f f 700~0x11f f af f (1024Byt e)
SVCSt ack EQU Ox11fffO0O0 ; Ox11f f bOO~0x11f f ef f (1024Byt e)

Define an Exception Handler Area From Ox11F FFOO - Ox11F_FF20

A Ox11fff00 ; One word per exception
Handl eReset # 4 ; Ox11f _ffO00~0Ox11f _ff O3
Handl eUndef # 4 ; Ox11f _ff 04~0x11f _ffO7
Handl eSwi # 4 ; Ox11f _ff08~0x11f _ffOb
Handl ePrefetch # 4 ; Ox11f _ffOc~0x11f _ff Of
Handl eAbor t # 4 ; Ox11f _ff00~0x11f _ffO03
Handl eReserv # 4 ; Ox11f _ff04~0x11f _ffO7
Handl el rq # 4 ; Ox11f _ff08~0x11f _ffOb
Handl eFi g # 4 ; Ox11f _fflc~Ox11f ff1f

Set Up a Reserved User Area from Ox11F_FF20 - 0x120_0000

AOx11fff 20
Reser ved # Oxe0
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ABOUT <INIT.S>

C language programs often employ many variable of various types and scopes. Auto-variables use registers and
the stack area, and global variables are allocated to memory area. When you link programs that use global
variables, you must then copy these variables from the read-only area in the DRAM to the DRAM'’s read/write
area. The ARM linker has several system variables that you can use to execute this operation:

Image$$RO$SLImIt Defines the end address of the ROM code area, which includes execution code
and read-only data.

Image$$RWS$Base Defines the RAM base address to be initialized. RAM is used for the read/write
area. The global variables are grouped into two categories:

Zero initialized area, with variables initialized to zero by the compiler.
Initialized area, which contains variables initialized by the program.
Image$$ZI$$Base Defines the base address of the Zero initialized area of the RAM.

Image$$ZI$SLimit Defines an end address of the Zero initialized area of the RAM.
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MEMORY MANAGEMENT

EXAMPLE CODE FOR <INIT.S>

The example code shown below uses the system variables described above to initialize the RAM read/write area.

AREA

ENTRY

Init,

CCODE, READONLY

; Initialise nenory required by C code

| MPORT | | mage$$ROBSLI mi t |

| MPORT | | mage$$RWG$Base|
| MPORT | | mage$$ZI $$Base|
| MPORT | I mage$$ZI $$Li mit |
LDR ro, =|1nage$$ROBSLI mit |
LDR rl, =|1nage$$RWs$Base|
LDR r3, =|1nage$$zl $$Base|
CcwP ro, rl
BEQ %
0 CcwP ri, r3
LDRCC r2, [r0], #4
STRCC r2, [r1], #4
BCC %0
1 LDR  r1, =|Inmage$$zl $$Limt|
MOV r2, #0
2 CcwP r3 rl
STRCC r2, [r3], #4
BCC %9
| MPORT Main
BL Mai n
END

End of ROM code (=start of ROM data)
Base of RAMto initialise

Base and |init of area

to zero initialise

Get pointer to ROM data

and RAM copy

Zero init base

( top of initialised data )
Check that they are different

Copy init data

Top of zero init segnent

Zero init

ELECTRONICS
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MEMORY ALLOCATION

Following system initialization, the DRAM area is mapped as shown in Figure 4-3 below.

The .heap area,. which is part of the data area structure, is used to allocate memory to an application program. In
a C program, you typically call the mal | oc( ) orfree( ) function to allocate memory. KS17C4000 memory is
allocated in much the same way. However, before you can use these functions, you must first initialize several
KS17C4000 environments, as described below.

DRAM Configuration Data Area Structure
Heap End ®
0x120_0000 OxL1F_E700
Reserved .
Ox11F_FF20
Exception Handler
Heap Area
Vector Table P
Ox11F_FF00
Mode Stack Area
Ox11F_E700
Data Area ( 1MB) Heap Base ® — Image$$RW$$Lin_1it.
Zero Initialized = Image$$ZI$$Limit
0x110_0000 Variables
Code Area ( 1MB) ) Image$$ZI$$Base
0x100_0000 Initialized Variables
0x110_0000d" Image$$RWS$Base

Figure 4-3. KS17C4000 DRAM Memory Map
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USING MALLOC( ) WITH THE KS17C4000

Before you can use the C language function mal | oc( ) with the KS17C4000, you must perform the following

steps:

1. Add the following files to the project: <CLib.c>. (These files are included in the KS17C4000 demo diskette.)

2. Define the HEAPEND value as an extern variable and assign an end address in a usable area. (This definition
is located in Clib.h file.)

3. Callmal I oc() . (This is similar to using mal | oc() and free() in ANSI C, as it returns the start address of
the allocated area.)

4. Callfree() to define the allocated area as free area. (If there are contiguous free areas, this function

combines them into a single, continuous, free area. This function does not, however, support memory
optimization.)
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EXAMPLE CODE USING THE MALLOC( ) FUNCTION

The following program code illustrates how to write a memory allocation routine using the malloc( ) function.

#i ncl ude <CLi b. h>

11

1/ HEAPEND val ue is defined in CLib.h

11

voi d Mal | ocTest (voi d)
{

unsi gned char Menttring[] = "Hello...... Al l ocated Menory. ..

char *All ocMenPtr;
unsigned long StrSize;

/1A'l ocation Menory
StrSize = strlen(Menttring);
Al l ocMenPtr = (char*)mall oc( (unsigned)StrSize);
i f(AlocMenPtr ==NULL)
exit(0);

strcpy( Al ocMenPtr, Mentri ng) ;

[IPrint to view address of allocated nenory and Val ue..

Print("\r[ Addr : Ox%9©8X ] - %", AllocMenPtr, AllocMenPtr);

/] Free Menory areas...
free(All ocMenPtr);

}
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WRITING ROM CODE

This chapter introduces how to develop a project without Embedded ICE and to write a code for a Boot ROM
program and a Standalone ROM program. Building a ROM program is also shown. Information is presented
according to the following Table of Contents:

INEFOAUCTION ... 5-2
Building a Project without Embedded ICE ...........cc.vveiiiiiiiii e 5-3
Downloading an Image from the HOSE ... 5-4
BOOt Program SEIUCIUIE ......cooeeiiiiiiiie et e e e e e e e e e e e 5-5

ROOt OPEeration SITUCTUIE.....ccoi oo 5-5

Supplement Operation StrUCIUIE ..o 5-5
BUIldiNG 8 ROM PrOGIAM ......uviiiiieiiiiiiiiiit ettt e e e e e e e e e s s e e e e e e e e e 5-6
Making the ROM COdE.........ccoiiiiiiiiiiiiiii 5-7
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INTRODUCTION

Before you can develop programs using the KS17C4000 demo board, you must first set up your system
configuration in the boot ROM. Then, after you have developed your program, you may wish to create a
standalone ROM program.

This chapter describes how to construct simple ROM images, boot ROM images or standalone ROM images for
the KS17C4000 MCU. Both types of programs have similar structures except for downloading and debugging
functions. A typical boot ROM program is included as an illustration.

This chapter also describes how to perform downloads and execute an application program on the KS17C4000
demo board without EmbeddedICE, in which case hardware debugging is not supported. The downloads are
performed using the ARM project manager and various utility programs over a serial port. Without
EmbeddedICE, you cannot use the ARM Debugger for Windows and the following functions are not available:
Stepping through a program
Setting a breakpoint or watchpoint

Viewing registers, variables, and memory

Other useful debugging techniques

The techniques described below can help you test program functions without EmbeddedICE. They will, however,
require some modification for specific applications.
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BUILDING A PROJECT WITHOUT EMBEDDED ICE

This technique is similar to building a project with EmbeddedICE, except for the requirement that the Output
Format linker option must be set.

1. When using the Project Manager to configure the linker option, set the Output page as follows:
[Output Formats] | Plain binary (not Absolute AIF)

2. To use the command to perform a build, add the following to the linker option:
armlink -bin <....>

The .Plain binary. option means that the linker produces code with ho debugging information or header, as
compared with the AIF format which contains this information.
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DOWNLOADING AN IMAGE FROM THE HOST

Without EmbeddedICE, the ARM Debugger for Windows does not let you download a program to DRAM on the
KS17C4000 demo board. You can, however download the application image to DRAM by executing the DOS
programs Sf t p. exe. These programs download the application image file to DRAM through a serial port.

To download a executable application image to DRAM , follow these steps:

1. Start download program on Hyper Terminal.
Select test item: “ 1" (User Program Download)

2. Start download program on host computer.
"Sftp.exe” is used for download application image. This application program is compiled on Windows’95,
and the compiler is Visual C++. If you are in a different environment you should recompile.

USAGE : SFTP <COM PORT> <FILE NAME>

EXAMPLE : sftp 1 ks17¢c4000.dwn

3. When the download is finished without any error, press any key to start the download user program.
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BOOT PROGRAM STRUCTURE

The following boot program structure is provided as an example, and does not represent a standardized
structure. Boot programs will vary according to system environment or application type.

The basic structure consists of two program sections: the root operation, and the supplement operation.
ROOT OPERATION STRUCTURE

This program block is required to configure your system and must be coded in the ARM assembly language. It
consists of the following function modules:

Set up exception vectors for each mode
Set up the stack area for each mode

Configure the memory map

SUPPLEMENT OPERATION STRUCTURE

This program block contains additional function modules. These modules can be coded in C and/or ARM
assembly language. ( Download, Function Test, Etc. )

Show board reset status (Display a message or illuminate a LED)
If you are using Embedded ICE, wait until the Embedded ICE starts the DRAM download operation.

If you are not using Embedded ICE, wait until the host initiates the program transfer operation starts over the
serial port. The host then downloads the code to the DRAM.

For detailed example flow chart and code of a Boot program, please refer to Chapter 7 of this manual.
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BUILDING A ROM PROGRAM

The procedure for building a boot ROM or standalone ROM program is somewhat different than for building an
application program for downloading. The following procedure description outlines these differences:

When using the ARM Project Manager to build a ROM program, you must select Release as the variant (not
Debug).

1. Set the configuration linker options as follows:
Output page
[Output formats] | Plain binary (not Absolute AlF)
Entry and Base page [Image Base]
<Read-only> | 0x0 (Start address of the ROM bank)
<Read/write> | 0x1100000 (Start address of the RAM data area)
Image Layout page [Place at beginning of image]
<Object file> | Init.o (Beginning object file)
<Area Name> | Init (Beginning area)
(File .Init.s. contains the root block.)
2. For the build command, add the following to the linker option entry:

armink -bin -first Init.o(lnit) -Base 0x0O - DATA 0x1000000 <...>
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MAKING THE ROM CODE

Because of the characteristics of the KS17C4000 Demo Board’'s memory structure, you must split ROM code in
order to write a program to the ROM. To perform this ROM code split, you use the program .split2.exe., which
split ROM code to even and odd bytes. (The split program is included in the KS17C4000 demo diskette.)

For example, the following command splits ROM code even bytes and odd bytes.
split2 ks17c4000.rom

The following DOS code makes the ROM code for the KS17C4000 demo board (it is not applicable to all
environments or applications):

split2 ks17c40000.romevn odd ; Split code to even and odd files.
bi n2hex evn evn.hex 0 0 O ; Convert binary format to hex fornat.
bi n2hex odd odd.hex 0 0 O

The DOS programs .split2. and .bin2hex. are also included on the KS17C4000 demo diskette.
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Notes
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KS17C4000 CONTROL MODULES

This chapter presents concept diagrams and example programs for configuring various KS17C4000 system
control functions. Information is presented according to the following Table of Contents:

SYSTEM MANAGEN ...ttt ettt e e et e e e e e et e e e e r e e e e e e e e 6-2
Example system manager configuration program ... 6-3
01T U] o PSPPI PPRPPPPPPIN 6-4
Example interrupt handler routine <EXCeption.C> ..., 6-6
Example interrupt setup routine - HEADER FILE <Exeption.h>................ccoeees 6-7
Example interrrupt setup routine <EXeption.C>.........cooovviiiiiiiiiiiiien 6-8
Timer module 0 (16-Bit tIMEIS) ..ccoeei i 6-9
Timer module 1 (8-Bit tIMErS) ...ccoeeei i 6-10
Example code for Setting tiMers .......oooooieo oo 6-11
LU O SR 6-12
Example code for UART setup routine <CLib.C> ..., 6-14
DIV A ettt e e e e e e — e —— e e e e e e e et b ettt et ee e e e e e nrrareaeaaeesaannnrnaees 6-16
Example code ofr setting up and excuting DMA ..., 6-17
/O POITS. e 6-18
Example 1/O port SETUP FOULINE ......cooeeeeeeeeeeeee e 6-19
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KS17C4000 PROGRAMMER'S GUIDE

SYSTEM MANAGER

System Manager Configuration

[ Define System Memory Map ]

A

To initialize the System Register Address Configuration
Register (SYSCFG), specify the following values :

- Start address of SFRs (Special Function Registers)
- Cache size & enable (if needed)

- Write buffer enable (if needed)

- Stall enable (if needed)

- Address Mux enbale(if needed)

A

To initialize Memory Bank(ROM/SRAM, DRAM), Extra Device,
DRAM refresh control register, specify the following values :

- Memory type

- Bus width

- Bank location and size

- Number of access cycles

- Etc.

A

Write specified values simultaneously to
System Manager Registers

Figure 6-1. System Manager Concept Diagram
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EXAMPLE SYSTEM

MANAGER CONFIGURATION PROGRAM

/1 Setup Register SYSCFG

i - Speci al Register Addr(SFR Start Address) : Ox1FF0000

i - System Regi ster Address Configuration Regi ster(SYSCFG : Ox1FF1000
ADRL RO, SysCfgData ; 2K cache node(cache off), Wite Buffer on.
LDR Rl, [RO] ; System Configuration Reg.
LDR RO, =0x1FFO000 + 0x1000 ; Base addr SetVal ue = Ox1FF
STR Rl, [RO] ; Base addr = Ox1FF0000

/1 Configure Me

;11 - You nust
;11 - Set nenor
ADRL RO,
LDM A RO,
LDR RO,
STMA RO,

// Additional co

nory Allocation. This operation nust be done at once...
use ' STMkx' instruction for setting the nenory configuration.
y control registers(MEMCONO/ 1/2/3 and REFCON) with specific val ues.

SysManager Dat a ; Load address of area 'SysManager Dat a'
{R1- R5} ; Load each word val ue of SysManager Dat a
=0x1FFO000 + 0x2000 ; MEMCONO Offset : 0x2000

{R1- R5} ; Store each value to MEMCONO-~3,

; REFCON registers..... ;
de

SysCf ghat a DCD SFRSt art Add+Cache2KMbde+W i t eBuf Enabl e

SysManager Dat a

DCD 0x402
DCD 0x101
DCD 0x252
DCD 0x400
DCD 0x100

+ (0x000<<14) + (0x002<<23) ; Two x8 EPROM (Boot ROV
b + (0x100<<14) + (0x120<<23) ; One x16 EDO DRAM 2MB)
+ (0x120<<14) + (0x128<<23) ; One x16 SRAM 512KB)
+ (0x128<<14) + (0x130<<23) ; One x8 SRAM 512KB)
1+ (2.10111111110<<1) ; 15.6us, VSF ON, Refresh Enabl e.
Special Reqgisters OXLFF_0000
N.A 0x130_0000
Bank3 (One X8 SRAM)
0x128 0000
Bank2 (One X16 SRAM)
0x120_0000
Bank1 (One X16 DRAM)
0x100_0000
N.A
0x020_0000
BankO (Two X8 ROM)
0x000_0000

Figure 6-2. System Manager Memory Map (for Sample Program)
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INTERRUPTS

[ Interrupt Setup ]

Initialize INTMODE (Interrupt Mode) Register :
FIQ/IRQ

A

Initialize INTMASK (Interrupt Mask) Register :
Disable

A

Initialize INTPEND (Interrupt Pending) Register :
All Clear

A

Enable global mask bit in System Control Register :
SYSCON]6] :='1"'

A

Set up interrupt vector address for each interrupt source :
Set Interrupt vector with specified address of interrupt service routine

A

Enable interrupt mask bit for each interrupt source

A

< When interrupt occurs >

A

Interrupt Service Routine

Figure 6-3. Interrupt Handler Setup Concept Diagram
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( Example of Interrupt (Fiq / Irq) Handling Flow ]

/ FIQ / IRQ Exception Occurs /

v

Check INTMODE / INTMASK / INTPEND registers
-> IntRegValue = AND ( INTMODE, INTMASK, INTPEND )

IntRegValue =0 ?

No

Yes

A

Shift IntRegValue right by one bit Return

LNo IntRegValue & Ox1) =1 ?

Yes

v

Clear interrupt pending bit for the interrupt source
-> INTPEND [bit: interrupt source] :=0

Branch to corresponding interrupt service routine

Interrupt Service Routine

A

Main interrupt service routine

Figure 6-4. Interrupt Handler Concept Diagram
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EXAMPLE INTERRUPT HANDLER ROUTINE <Exception.c>

/1 [ Default 1 RQ Handl er Routine ]
void __irq IrgHandl er(void)

{
unsi gned int | ntRegVal ue;
unsi gned char i;
I nt RegVal ue = rI NTPEND & ~r | NTMODE & r| NTMASK ;
for(i=0; (IntRegValue) &% (i<32); i++)
{
if( IntRegvalue & 1)
{
C ear PendingBit(i); /1 Interrupt Acknow edge, C ear pending bit.
(*InterruptHandlers[i])(); // Junp to appropriate Interrupt
/1 service routine.
}
I nt RegVal ue >>= 1;
}
}

/1 [ Default FIQ Handl er Routine ]
void __irq FigHandl er(void)

{
unsi gned int | ntRegVal ue;
unsi gned char i;
I nt RegVal ue = rI NTPEND & ~r | NTMODE & r| NTMASK ;
for(i=0; (IntRegValue) &% (i<32); i++)
{
if( IntRegvalue & 1)
{
Cl ear PendingBit(i); /1 Interrupt Acknow edge, C ear pending bit.
(*InterruptHandlers[i])(); // Junp to appropriate Interrupt
/1 service routine.
}
I nt RegVal ue >>= 1;
}
}
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EXAMPLE INTERRUPT SETUP ROUTINE - HEADER FILE <Exeption.h>

/* ___________________________________________________________________________ */
/* Exeption.h : Header of Interrupt Setup Routine for KS17C4000 */
et T HINSPUSSPUSPRS */
N LR R KS17C4000 Intrrupt Source ------------------------- 1
#def i ne NEXTO | NT 0//P6.7

#defi ne NEXT1_| NT 1//P4.5

#defi ne nTI MERO_OVF_I NT
#defi ne nTI MERO_MC | NT
#defi ne nTI MER1_OVF_I NT

#defi ne nTI MER1_MC_| NT 10

#defi ne nTI MER2_OVF_I NT 11

#defi ne nTI MER2_MC_| NT 12

#defi ne nTI MER3_OVF_I NT 13

#defi ne nTI MER3_MC_| NT 14

#defi ne nTI MER4A_OVF_I NT 15

#defi ne nTI MER4A_MC_| NT 16

#defi ne nBT_I NT 17

#defi ne nSI Q0_| NT 18

#defi ne nSI OL_| NT 19

#defi ne NEXT2_| NT 20 /[1P1.0

#defi ne NEXT3_| NT 21 /P11

#defi ne NEXT4_| NT 22 [1P1.2

#def i ne NEXT5_| NT 23 /1Pl 3

#defi ne NEXT6_| NT 24 [1P1. 4

#defi ne NEXT7_| NT 25 [1P1.5

#def i ne NEXT8 | NT 26 /1Pl 6

#defi ne NEXTO_| NT 27 [1P1.7

#defi ne NADC | NT 28

#defi ne NEXT10_I NT 29 [1P7.0

#defi ne NEXT11_I NT 30 [1P7.1

#defi ne NEXT12_I NT 31 [1P7.2

#defi ne NGLOBAL_I NT 6 //SYSCON BIT 6

I LR Intrrupt Controll Macro Fuction ----------mmmmomnn /1
1

#defi ne Enabl e_I nt(n) ri NTMASK | = (1<<(n))
#define Di sable_Int(n) r1 NTMASK &= ~(1<<(n))
#define Genable_Int() r SYSCON | =0x40
#define GDisable_Int() r SYSCON &=~0x40
#define d ear_Pendi ngBit(n) r1 NTPEND &=~(1<<(n))

ELECTRONICS PRELIMINARY VERSION 1.0 6-7



KS17C4000 CONTROL MODULES KS17C4000 PROGRAMMER'S GUIDE

EXAMPLE INTERRUPT SETUP ROUTINE <Exeption.c>

/* ___________________________________________________________________________ */
/* Exeption.c : Exeption / Interrupt Setup Routine for KS17C4000 */
/* ___________________________________________________________________________ */

#i ncl ude "ks17c4000. h"
#i nclude "arnstdio.h"
#i ncl ude "exception.h"

/* ________________________________________________________________ *
| Functi on . void I nitExceptions(void) |
| Description : Initialize for Exception handle |
K o o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e */
voi d I nitExceptions(void)
{
pl SR_UNDEF =(unsi gned) Hal t Undef;
pl SR_SW =(unsi gned) Hal t Swi ;
pl SR_PABORT =(unsi gned) Hal t Pabort ;
pl SR_DABORT =(unsi gned) Hal t Dabort ;
pl SR_I RQ =(unsi gned) | r gHandl er;
pl SR_FI Q =(unsi gned) Fi gHandl er;
}
/* ________________________________________________________________ *
| Function : void SysSetlnterrupt() |
| Description : Setup Interrupt Handler Vector Table |
K o o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e */

voi d SysSetlnterrupt(volatile unsigned |ong vector, void (*handler)())

I nterrupt Handl ers[vector] = handl er;

*
| Function : drlntStatus

| Description : Cear Intrrupt Controller Register Val, &
| Interrupt Initialization.

*

$ ———

void drintStatus(void)

{
GDi sable Int(); /1 SYSCON 6]:="'0
/1 dobal Interrupt Enable bit = Disable
r1 NTMASK = 0xO; /1 Al Interrupt disabled, Not serve Int.
rI NTPEND = 0xO; /1 Al dear Pending
r I NTMODE = 0x0; /1 Al | RQ node
}
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TIMER MODULE 0 (16-BIT TIMERS)

Timer Module 0 Setup

Select operating mode. ( Interval, Capture, Match&Overflow mode )
Select Input clock. ( Internal, External clock )
Specify prescaler_value, count_value with following expression:
* Timer_duration := count_value x (prescale value +1)/Xin
* Timer_duration := count_value x External clock

v

Select input clock, operating mode in the TnCON register

A

Set prescaler value in the TnPRE register

A

Set count value in the TNDATA register

A

To start the timer operation,
set timer enable bit in the TnCON register

Figure 6-5. Concept Diagram for Setting a Timer Module O
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TIMER MODULE 1 (8-BIT TIMERS)

4 )
Timer Module 1 Setup
o J

Select operating mode. ( Interval, Capture, PWM mode)
Select Input clock. ( Fpre/16, Fpre/8, Fpre/4, Fpre/2, External clock )
Specify prescaler_value, divison_factor, count_value

with following expression:
e Timer_duration := count_value x ( prescale_value + 1)
xdivison_factor / Xin
* Timer_duration := count_value x External clock

v

Select input clock, operating mode in the TnCON register

A

Set prescaler value in the TnPRE register

A

Set count value in the TNDATA register

A

To start the timer operation,
set timer enable bit in the TnCON register

Figure 6-6. Concept Diagram for Setting a Timer Module 1
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KS17C4000 CONTROL MODULES

EXAMPLE CODE FOR SETTING A TIMER

/* ___________________________________________________________________________ */
/* Ti mer Setup Routine for KS17C4000 */
/* ___________________________________________________________________________ */
#i ncl ude "KS17c4000. h"
voi d Set Ti mer (voi d)
{
rP6CON &= ~ 0x1;
rP6PUR | = 0x1; /1 Set Port6.0 to TO _CK input for TinmerO.
r TODATA = OxFFFF;
rTOPRE = 0;
r TOCON = 0Ox(4; /1 TO: Ext CLK I nput.
/1 I nterval Mode.
/1 Enabl e Tinmer0
r P6CON &= ~(0x3<<5h);
rP6CON | = 0x2<<5;
rP6PUR | = 0x1<<5; /1 Set Port6.5 to T3QUT output for Tiner3.
r T3DATA = 51;
rT3PRE = 0;
rT3CON = 0xQU; /1 T3:. fPRE/ 16
/1 I nterval Mode
/1 Enabl e Tinmer3
rP6CON &= ~(0x3<<7);
rP6CON | = 0x2<<7;
rP6PUR | = 0x1<<6; /1 Set Port6.6 to T4PWM out put for Tiner4.
r TADATA = 50;
rTAPRE = 0;
rTACON = 0OxCB; /1 T4. fPRE/ 2
/1 PVWM Mode
/1 Enabl e Tiner4
}
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UART

[ UART Setup ]

Set the following values in the LCON registers :
Word length / Number of Stop bit / Parity mode/
Internal / External Clock

A

Write the Baud rate divisor value to the UBRDR registers.
Calculate this value as follows :
Divisor value = (int )( Source clock / ( Baud rate x 16 ) -1)

A

Set the following values in the UCON registers :
Receive mode / Receive status interrupt enable /
Transmit mode / Send break / Loop-back enable

Figure 6-7. Concept Diagram for UART Initialization
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[ Using the UART j

This example shows how to transmit and receive data
through UART using a polling method

A

[ UART Setup ]

Set LCON to 0x3 ( 8 word length / 1 stop bit / No parity / internal clock/
Normal mode)

Set UBRDR to 0x34 (38400 Bps / 33 MHZ)

Set UCON to Oxd (interrupt request Rx ,Tx / Enable Rx status interrupt)

/\

[ Transmit ] [ Receive ]

A

Yes

Check USSR][6]:
Transmitter holding register
empty ?

Check USSRI[5]:
Receive buffer register
empty ?

Yes No
TBR := TXdata RXdata := RBR

Figure 6-8. Concept Diagram for Using the UART
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EXAMPLE CODE FOR UART SETUP ROUTINE <CLib.c>

/* ___________________________________________________________________________ */
/* UART Setup Routine for the KS17C4000 */
/* ___________________________________________________________________________ */

#i ncl ude "KS17C4000. h"
#i ncl ude "CLi b. h"

/1 [ Check Receive ] /1
/1 1f valid data is present in the receive buffer, USSRs [5] bit is set.

/1 So you can check whether there is a data to read or not.

/1 This function can be used for comunication in the polling mnethod.

#define Wit Rcver (USSR) whi I e(! (USSR & USTAT RCV_READY))

/1 [ Check Transnit ] /1
/1 After transmission valid data is finished, USSR [6] bit is set.

/1 So you can check whether transmit data or not.

/1 This function can be al so used for conmunication in the Polling method.
#define WAitXmtter (USSR whi | e(! (USSR & USTAT_TXB_EMPTY))

voi d UARTPol I I nit(void))

{

/1 Set UART Line Control Register with ...

/1 . 8 word length, 1 stop bit, No parity, internal clock, Normal node...
rLCON = ULCON_W.S8;

/] Set Baud rate with...
/1 38400 Bps @ 33MHz.
r UBRDR = (unsi gned short) (f MCLK/ (16* BAUDRATE) - 1) ;

/1 Set UART Control Register with...

/1 . Interrupt request Rx, Interrupt request Tx
r UCON = (UCON_RXM_I NTREQ UCON_TXM I NTREQ) ;

}

/1 [ General Function for Polling ] /1

/1 Transmit one byte through UART...
voi d put _char (char ch)
{
/1 Wait until UART Trasmit buffer register is enpty...
/1 when enpty, transmit new data.
VWait Xm tter(rUSSR);
rTBR = ch;
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(continued...)

/1 Transmit string through UART...
void put_string(char *ptr )

{

}

while(*ptr ) put_char(*ptr++ );

/1 Receive one byte through UART...
char get char (voi d)

{

char ch;

/1 Wait until UART Receive buffer register has valid data...
/1 When data is vaild, receive new data...

Wi t Rever (r USSR) ;

ch = rRBR;

return ch;
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DMA

[ DMA Setup ]

Set the following values in the DMANCON register :
Run disable / Mode selection / Transfer width /
Source, Destination address attributes / Data transfer modes

A

Assign DMA source address value to the DMAnSRC registers

A

Assign DMA destination address value
to the DMANDST registers

A

Assign DMA transfer count value to the DMANCNT registers

A

Set DMA Run enable bit in the DMANCON registers

Figure 6-9. Concept Diagram for Setting Up DMA
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KS17C4000 CONTROL MODULES

EXAMPLE CODE FOR SETTING UP AND EXECUTING DMA

| F o e o m e e e e e e o e e e e e e e o e e e e e e e e o e o e o e e e e e e e e e e e e e memea—ao -
/* DMA Setup Routine for KS17C4000

/*: Set DMAO in order to transfer data fromnenory to UART in Single node

| F o e o m e e e e e e o e e e e e e e o e e e e e e e e o e o e o e e e e e e e e e e e e e memea—ao -
#i ncl ude "KS17C4000. h"

#defi ne MessageArea 0x1200000 /1 Message area in DRAM

#defi ne SizeMessage 0x100 /1 Size of message to be transfered

voi d DMASet up(voi d)

{

11
11
11
11

11
11

11
11

11
11

11

Set DVA Control Register with...
UART node, Enable Stop interrupt, Menory to UART,
Singl e node, Byte transfer wi dth, Source address increase,
Destination address fix...
r DVAOCON = 0x54c;

Set DMA Source Address
Menory( Message area).

Regi ster with. ..

r DMAOSRC = MessageAr ea;

Set DWVA Destination Address Register with...
UART Tx Buffer Register...

r DMAODST = (unsi

Set DMA Transfer Count
Si ze of Message. ..

gned int)&rTBR);

Regi ster with. ..

r DMAOCNT = Si zeMessage;

Run DVA by set run_enable bit... when you wi sh. ..

r DVAOCON | = Ox1;

*/
*/
*/
*/

ELECTRONICS

PRELIMINARY VERSION 1.0
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I/O PORTS

[ Configure I/0 Ports j

To use I/O ports, read or write each port data
in the Port n register, after setting mode for each port
in Register PNCON

A

Set port mode in the PNCON register
( Input / Output / Control )

A

Set Pull up/down mode in the PnPUR/PnPDR register
( Enable / Disable )

Read or Write port data using the Port n register

Figure 6-10. Concept Diagram for Configuring I/O Ports
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KS17C4000 CONTROL MODULES

EXAMPLE I/O PORT SETUP ROUTINE

void Port_lnit(void)

{

I/O Port Setup Routine for

KS17C4000

/1 CAUTI ON: Fol | ow t he configuration order for setting the ports.

/1 1) setting control

register

/1 2) configure pull-up/down resistor.

r EIl NTCON = 0x000;
r EIl NTMOD = 0x000000;// F F FF F F

r POCON=0xcO;
r POPUR=0x00;

r PLPDR=0xf f ;
r PLCON=0x0700;

r P2CON=OXffff;
r P2PDR=0x0;

r P3CON=0Oxaaaa,;
r P3PUR=0x00;

r PACON=0x155;
r PAPUR=0x0;

r P5CON=0x05b4b4;
r P5SPUR=0x88;

r P6CON=0x2bf ;
r P6PUR=0xO0;

r P7CON=0x00;
r P7TPUR=0xf f ;

//12 11 109 8 7 6 5 4 3 2
// D D Db bD b D D D D D
F F F F F
//0.00.10.20.30.40.50.60.7
/11 I I I I I O O
//f Db D D D D D D D
//1.01.11.21.31.41.51.6 1.7
/1 E E E E E
/I A A A | | | | |
/12.02.12.22.32.42.52.62.7
//f Db D D D D D D D
//f Db D D D D D D D
//3.0 3.13.23.33.43.53.6 3.7
/f C C € C C € c cC
//f Db D D D D D D D
[14.0 4.1 4.2 4.3 4.4 4.5
// O O O O O O
/1 D
//5.05.15.25.35.45.55.65.7
/11 X X IlU (O (O x U
/[l Rx, Tx, SQ0, SIO0, SCK0, 1, SO1, Sl1
//6.06.16.26.36.46.56.66.7
//O O O O O O O o
/1
/17.07.17.27.37.47.57.67.7
//TU 1TU U IU U U U 11U
// Normal in/out

1 0
D D (D disable Ext In
F F (F:falling edge)

(I:input, G output)
(D: di sabl e Pull up)

(E:enabl e Pull
(A addr ess,

up)
I :input)

(D: data bus)

(D: di sabl e Pull down)

(C control signal)
(D: di sabl e Pull down)

(O out put)

(D: di sabl e Pull up)
76 5 4 32 1 0
001011011010010110100
05 B 4 B 4

76 5 43210
1010111111
2B F

t.)
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Notes
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<Exeption.h> (Continued)

#defi ne NEXT10_I NT 29 [1P7.0

#defi ne NEXT11_I NT 30 [1P7.1

#defi ne NEXT12_I NT 31 [1P7.2

#defi ne NGLOBAL_I NT 6 /1 SYSCON BIT 6

I L KS17C4000 Exception Handler Table --------------mmomonno- /1
1

#defi ne pl SR_RESET (*(unsi gned *)(_I SR_STARTADDRESS+0x0) )

#defi ne pl SR_UNDEF (*(unsigned *)(_I SR_STARTADDRESS+0x4) )

#defi ne pl SR_SW (*(unsigned *)(_I SR STARTADDRESS+0x8))

#defi ne pl SR_PABORT (*(unsigned *)(_I SR_STARTADDRESS+0xc) )

#defi ne pl SR_DABORT (*(unsigned *)(_I SR_STARTADDRESS+0x10))

#defi ne pl SR_ RESERVED (*(unsigned *)(_Il SR _STARTADDRESS+0x14))

#defi ne pl SR_I RQ (*(unsigned *)(_I SR_STARTADDRESS+0x18))

#defi ne pl SR_FI Q (*(unsigned *)(_I SR_STARTADDRESS+0x1c))

I Intrrupt Controll Macro Fuction ----------mmmmmmmnn /1
1

#defi ne Enabl e_I nt (n) r1 NTMASK | = (1<<(n))

#defi ne Di sabl e_I nt(n) r1 NTMASK &= ~(1<<(n))

#defi ne CGEnabl e_Int () r SYSCON | =0x40

#defi ne GDi sable_Int() r SYSCON &=~0x40

#defi ne Cl ear _Pendi ngBi t (n) r1 NTPEND &=~(1<<(n))

I Intrrupt Controll Fuction -----------c-mmommomnoon /1
1

extern void SysSetlnterrupt(volatile unsigned |ong vector, void (*)());
/1 Function Prototype for Interrupt Setup

extern void |nitExceptions(void); /1 Initialize Exception vectors
extern void ArlntStatus(void); /1 Clear all interrupt related register
#endi f /] _EXCEPTI ON_H_
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EXCEPTION HANDLER PROGRAM: <Exception.c>

/1

Il KS17C4000 Denmo Program
/1

/1; File: Exception.c

/1

/1; Date: 1999.04.01

/1

/1; Author: Jinwook Jang, E-nmail: newnedi a@ansung. co. kr
/1

/1; Description:

Il 1. Default Interrupt Service Routine

/1

Il 2. Default Interrupt Service Routine Table
/1

Il 3. Default Exception Handl er Routine

/1

/1

#i ncl ude "ks17c4000. h"

#i ncl ude "CLi b. h"

#i ncl ude "exception. h"

vol atile unsigned int ExtlntDoneFlag = 0 ; // External Interrupt done flag

/1 [ Default Interrupt Service Routine ]

void IntHdl r_ADC(void){ Print("\rADC exception!"); }
void IntHdl r_BTIMER(void){ Print("\rBT exception!"); }
void IntHdl r_EINT(void){ Print("\rEINT exception!"); ExtlntDoneFlag = 1; }

void IntHdl r _TOMC(void){ Print("\rTO Match & Capture exception!"); }
void IntHdl r _TIMZ(void){ Print("\rT1l Match & Capture exception!"); }
void IntHdl r _T2MZ(void){ Print("\rT2 Match & Capture exception!"); }
void IntHdl r _T3MZ(void){ Print("\rT3 Match & Capture exception!"); }
void IntHdl r _T4MZ(void){ Print("\rT4 Match & Capture exception!"); }

void IntHdl r _TOOVF(void){ Print("\rTO OVF exception!");
void IntHdl r _T1OVF(void){ Print("\rT1l OVF exception!");
void IntHdl r _T20OVF(void){ Print("\rT2 OVF exception!");
void IntHdl r _T3OVF(void){ Print("\rT3 OVF exception!");
void IntHdl r _T4OVF(void){ Print("\rT4 OVF exception!");

e e o

void IntHdl r_SI Q(void){ Print("\rSI Q0 exception!"); }
void IntHdlr_SIOL(void){ Print("\rSIOL exception!"); }

void IntHdl r _UARTRX(void){ Print("\rRX Intrrupt!"); }
void IntHdl r _UARTTX(void){ Print("\rTX Intrrupt!"); }
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<Exception.c> (Continued)
void I ntHdl r UARTERR(voi d)

{
unsi gned char i;
Print ("UART error exception!\t");
i = rUSSR
if(i & Ox1) Print("Over Run Error\r");
if(i & Ox2) Print("Parity Error\r");
if(i & Ox4) Print("Frame Error\r");
if(i & Ox8) Print("Break Interrupt\r");
}

void IntHdl r _DMAO(void){ Print("\rDMAO exception!"); }
void IntHdl r_DVAL(void){ Print("\rDVAL exception!"); }

/| ========== [ Default Interrupt Service Routine Table | ===========

extern void (*InterruptHandl er s MAXHNDLRS] ) (voi d) ={
IntHdl r _EINT , I nt Hdl r _El NT, I nt Hdl r _UARTRX, | ntHdlr_ UARTTX,
I nt Hdl r _UARTERR, | nt Hdl r _DVAO, I nt Hl r _DVA1, I nt Hdl r _TOOVF,
I nt Hdl r _TOMC, IntHdl r _T1OVF, IntHdlr_T1MC, I nt Hl r _T20OVF,
I nt Hdl r _T2MC, IntHdl r _T3OVF, IntHdlr_ T3M I nt Hdl r _T4OVF,
I nt Hl r _T4MC, I nt Hdl r _BTI MER, I ntHdlr_SIQO, I ntHdl r_SIO1,
I nt Hdl r _El NT, I nt Hdl r _El NT, I nt Hdl r _El NT, I nt Hdl r _El NT,
I nt Hdl r _El NT, I nt Hdl r _El NT, I nt Hdl r _El NT, I nt Hdl r _El NT,
I nt Hdl r _ADC, I nt HAl r _EI NT, I nt HAl r _EI NT, I nt Hl r _EI NT
i
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<Exception.c> (Continued)
/1 [ Default Exception Handl er Routine ]

void __irg HaltUndef(void){ Print("\rUndefined Instruction"); while(l); }
void _irg HaltSw (void){ Print("SW exception!!!\n"); while(l); }

void __irq HaltPabort(void){ Print("\rAbort(Prefetch)"); while(1); }

void _irqg HaltDabort(void){ Print("\rAbort(Data)"); while(l); }

void __irq IrgHandl er(void)

{
unsi gned i nt |ntRegVal ue;
unsi gned char i;
I nt RegVal ue = rI NTPEND & ~r | NTMODE & r| NTMASK ;
for(i=0; (IntRegValue) && (i<32); i++)
{
if( IntRegvalue & 1)
{
Cl ear PendingBit(i); /1 Interrupt Acknow edge,
/1 Cdear pending bit.
(*InterruptHandl ers[i])(); /1 Junp to appropriate Interrupt
/1 service routine.
}
I nt RegVal ue >>= 1;
}
}

void __irq FigHandl er(void)

{
unsi gned int |ntRegVal ue;
unsi gned char i;
I nt RegVal ue = rI NTPEND & ~r | NTMODE & r| NTMASK ;
for(i=0; (IntRegValue) &% (i<32); i++)
{
if( IntRegvalue & 1)
{
Cl ear PendingBit(i); /1 Interrupt Acknow edge,
/1 Cdear pending bit.
(*InterruptHandl ers[i])(); /1 Junp to appropriate Interrupt
/1 service routine.
}
I nt RegVal ue >>= 1;
}
}
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<Exception.c> (Continued)

| Functi on : void InitExceptions(void) |
| Description : Initialize for Exception handle |

void I nitExceptions(void)

{
pl SR_UNDEF =(unsi gned) Hal t Undef ;
pl SR_SW =(unsi gned) Hal t Swi ;
pl SR_PABORT =(unsi gned) Hal t Pabort ;
pl SR_DABORT =(unsi gned) Hal t Dabort;
pl SR I RQ =(unsi gned) | r gHandl er;
pl SR FI Q =(unsi gned) Fi gHandl er;

}

/* ________________________________________________________________ *
| Function : void SysSetlnterrupt() |
| Description : Setup Interrupt Handler Vector Table |
K o o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e */

voi d SysSetlnterrupt(volatile unsigned |ong vector, void (*handler)())

I nterrupt Handl er s[vector] = handl er;

}
| o o e o e o o e e e e e eieieee—oo.
| Function : drlntStatus |
| Description : Cear Intrrupt Controller Register Val, & |
| Interrupt Initialization |
K o o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e */
void drintStatus(void)
{
GDi sable Int(); /1 SYSCON 6]:="'0
/1 dobal Interrupt Enable bit = Disable
r1 NTMASK = 0xO; /1 Al Interrupt disabled, Not serve Int.
rI NTPEND = 0xO; /1 Al dear Pending
r I NTMODE = 0x0; /1 Al | RQ node
/1 CGEnable Int(); /1 SYSCON 6]:="1"'
/1 dobal Interrupt Enable bit = Enable
}
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USER DEFINED C LIBRARY HEADER: <Clib.h>

/1
/1 KS17C4000 Denmo Program
/1
/1 File: CLib.h

/1

/] Date: 1999.04.01

/1

/1 Author: Edited by Jinwook Jang E-mail: newnedi a@ansung. co. kr

/1

/1 Description: Some libraries for standard input through UART shch as
/1 get _char, put_char, put_string, Print etc.

/1
/1

#i fndef _CLIB_H
#define _CLIB H

/* _____________________________________________________________________ */
/* Synbol Definitions */
/* _____________________________________________________________________ */
#defi ne NL Ox0A //Line feed

#defi ne CR 0Ox0OD //Carige Return

#defi ne BSP 0x08 //back space

#defi ne ESC 0x1B //Escape

#defi ne CTRLZ Ox1A /lctrl”nz

#defi ne RUBQUT Ox7F [//del, rubout

#defi ne LTRUE OxFF

#defi ne FALSE 0

#defi ne NULL 0

#defi ne DEFAULT -1

#defi ne DEFAULT_P 6 /* default precision */

/* _____________________________________________________________________ */
/* I nput buffer */
/* _____________________________________________________________________ */
#def i ne I NP_LEN 100
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<Clib.h> (Continued)

/* _____________________________________________________________________ */
/* This structure is used to store informati on obtained fromparsing a */
/* format specifier. */
/* _____________________________________________________________________ */
t ypedef struct
{

[ ong wi dt h; /] field width

[ ong precision; /1 precision specifier

unsi gned | ong count; /1 character count

/1 BOOLEAN flags with default val ues

unsi gned char space; /1 FALSE

unsi gned char right; /1 TRUE

unsi gned char alter; /1 FALSE

unsi gned char pl us; /1 FALSE

unsi gned char zero; /1 FALSE

unsi gned char nod; /1 process nodifier

unsi gned char type; /1 conversion type
} FORMAT;
/* _____________________________________________________________________ */
/* Buffer structure - used to set up the formatted output. */
/* _____________________________________________________________________ */

#defi ne BUFFSI ZE 60
t ypedef struct

{
unsi gned char buff [ BUFFSI ZE] ; /1 data buffer
unsi gned char *ptr; /1 ptr to current position in buffer
unsi gned char *end; /1 last position in buffer */
} BUFFER
/* _____________________________________________________________________ */
/* Macro Function */
/* _____________________________________________________________________ */
#defi ne is_digit(x) ((x >='0" & x <='9") ? 1:0)
#defi ne i s_| oner case(x) ((x >="'"a" & x <="'2") ? 1:0)
#defi ne i s_xdigit(x) ((is_digit(x) || (x >"A && x <="'F))? 1:0)
#defi ne i s_36digit(x) ((is_digit(x) || (x >"A && x <='Z"))7? 1:0)
#defi ne t o_upper (x) ((is_lowercase(x)) ? x - '"a" + '"A: x)
#defi ne i s_space(x) (((x=="")]||(x==0x0D)) ? 1:0)
#defi ne is_control (x) ((x >0 && x < 32) ? 1:0)
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<Clib.h> (Continued)

K o o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e *
;* Function Prototypes console in/out *;
K o o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e *
;/ UART MACRO FUNCTI ONS :
#def i ne USTAT_TXB_EMPTY 0x40
#def i ne USTAT _RCV_READY 0x20
| o o e o e o o e e e e e eieieee—oo.

Macro Function : Wit Xmitter (USSR
Description : Wiiting for Tx Buffer Register Enpty

After transnmission valid data is finished, USSR 6] bit is set.
So you can check wheter transmit data or not.

This function can be also used for comruni cation in the
pol | i ng net hod.

$—_———————

_________________________________________________________________ /
#defi ne Wai t Xm tter (USSR) whil e(! (USSR & USTAT_TXB_EMPTY))
| o o o o e e e e e e e e i eiedeeoo -

| Macro Function : WitRcver (USSR) |

| Description : Witing for Receive Data

| |

| If valid data is present in the receive buffer, USSR 5] bit is|

| set. So you can check whether there is a data to read or not.

| This function can be al so used for comunication in the |

| polling method. |

_________________________________________________________________ */
#defi ne Wi t Rever (USSR) whi I e(! (USSR & USTAT RCV_READY))

#define Serial Pol | Conin() get _char ()
#def i ne Seri al Pol | Conout (¢) put char (c)
#define Serial Pol | Const s(n) (1)

extern char get_char(void);

/1 Wite byte data to console through serial port. This function were
/1 inplenented use by polling nethod

extern void put_char(char /*ch*/);

/! Wite string data to console through serial port. This function were
/1 inplenented use by polling nethod

extern void put_string(char * [*ptr*/);

extern unsigned long Print(char * /*format */, ...);
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<Clib.h> (Continued)

/***********************************************************************/

/* read_string: Read a string fromthe input */
/* */
/* RETURNS: nunber of characters in the string */
/* QUTPUTS: *dest _ptr contains the null-term nated string. */
/* */
/***********************************************************************/
#defi ne get _string(s) read_string(s)

extern unsi gned char read_string(char */*dest ptr*/);

/***********************************************************************/

/* read_nunber: Read a nunber fromthe input */
/* */
/* RETURNS: nunber */
/* */

/***********************************************************************/

extern unsi gned | ong get nunber(void);

#endi f /*End of _CLIB H*/
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USER DEFINED C LIBRARY: <Clib.c>

/1

/1 KS17C4000 Denmo Program

/1

/1 File: Arnmstdio.c

/1

/] Date: 1999.04.01

/1

/1 Author: Edited by Jinwook Jang E-nail: newnedi a@ansung. co. kr
/1

/1 Description: Some libraries for standard input through UART shch as
/1 get _char, put_char, put_string, Print etc.

/1

/1

#i ncl ude <stdarg. h>

#i ncl ude "ks17c¢4000. h"

#i ncl ude "arnmstdi o. h"

static unsigned char read_nun(char *,unsigned char , unsigned long *);

static void strout(FORVAT *, unsigned char *,long);
static char *percent(char *, FORMAT *, va list *);
voi d copy(void *dstp, void *srcp, |ong count);

char inp_buff[INP_LEN; /11 nput buffer
unsi gned char inp_cnt; /1 # of chars currently in buffer
2

| Function : void get_char(char) |
| Description : Receive one byte through UART... |

char get char (void)

{

char ch;

/1 Wait until UART Receive buffer register has valid data...
/1 When data is vaild, receive new data...
Wi t Rever (r USSR) ;
ch = rRBR;
return ch;
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<Clib.c> (Conti
| Funct i
Descri

I nput s

nued)

on : void copy(void *dstp, void *srcp, |ong count)

ption : Copy nenory

: dstp = pointer to destination
srcp = pointer to source
count = nunber of bytes to copy

voi d copy(vo

{

char *ds
dst (c

src = (c
while (c

Functi
Descri

NOTES:

Return :

id *dstp, void *srcp, long count)
t, *src;

har *)dstp;
har *)srcp
ount--) *dst++ = *src++,;

on : void getch(void)

ption : Get a character from consol e,
wai ting if necessary.

Val ue of character

1. Handl es backspaces

2. Doesn't echo characters or update the input

(unl ess character is backspace)

buf f er

unsi gned char getch(void)

{
unsi gned char c;
for (;;)
{
/ K o o e o e e e e e e e e e e o e e e e e e e e e e e e e e e e e e o e e e e e e e e e e e e e e e e e e e */
/* Get a character when it is typed in. Translate linefeed to CR */
/ K o o e o e e e e e e e e e e o e e e e e e e e e e e e e e e e e e o e e e e e e e e e e e e e e e e e e e */
whil e (Serial Poll Consts(0) == 0);
c = Serial Poll Conin() & Ox7F;
if (c == NL) ¢c =CR
/ K o o e o e e e e e e e e e e o e e e e e e e e e e e e e e e e e e o e e e e e e e e e e e e e e e e e e e */
/* Handl e backspace */
/ K o o e o e e e e e e e e e e o e e e e e e e e e e e e e e e e e e o e e e e e e e e e e e e e e e e e e e */
if ((c == BSP) || (c == RUBQUT))
{
if (inp_cnt > 0)
{
Print("\b \b");
inp_cnt--;
}
}
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<Clib.c> (Continued)

/* _________________________________________________________________ */
/* Don't allow the input buffer to overfl ow */
/* _________________________________________________________________ */

else if (inp_cnt >= | NP_LEN)

Seri al Pol | Conout (7);

/* _________________________________________________________________ */
/* Skip control characters (other than backspace and CR) */
/* _________________________________________________________________ */
else if ((c <= CTRLZ) && (¢ !'= CR))
conti nue;
/* _________________________________________________________________ */
/* Qtherwi se just return the character */
/* _________________________________________________________________ */
el se
return c;
}
}
| o o e o e o o e e e e e eieieee—oo.

Description : Get a line of input

*

| Function : static void get_line(void)

|

| Qutputs : inp_buff[] and inp_cnt are updated

$ ———

static void get_line(void) :
{ unsi gned char c;

inp_cnt = 0;

while ((c = getch()) !'= CR

{ i np_buff[inp_cnt++] = c;

}
} inp_buff[inp_cnt] = 0;
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<Clib.c> (Continued)

| Function : unsigned char read_string(char *dest_ptr)

| Description : Read a string fromthe input

| Returns : nunber of characters in the string

| Qutputs : *dest _ptr contains the null-terninated string.

$ ——— —

unsi gned char read_string(char *dest _ptr)

{

char *src_ptr, count;

get _line();

count = 0;

src_ptr = inp_buff;

while ((*dest _ptr++ = *src_ptr++) = 0)
count ++;

return count;

*

| Function : unsigned | ong get nunber(voi d)
| Description : Read a nunber fromthe input
| Returns : nunber

$ ———

unsi gned | ong get_nunber (voi d)

{
char nuni10];
unsi gned | ong nunber =0;
read_string(num;
if((nunf0]=="%")[|(nun{1]=="x")|| (nun{1]=="X"))
read_nun{num 16, &unber);
el se
read_nun{num 10, &unber);
return nunber;
}
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<Clib.c> (Continued)

{

Function : static unsigned char read_nun{char *ptr,

unsi gned char base,
unsi gned | ong *val _ptr)

Description : Interpret a string as a numnber
I nputs : base = 10 or 16
Qutputs : *val _ptr = New value (if function returns TRUE)

Returns : TRUE if a new nunber was entered

I
I
I
I
I
I
I
I
*

Notes : *val _ptr = New value (if function returns TRUE)i s
delimted by a null or a space.
_____________________________________________________________________________ /
static unsigned char read_nun(char *ptr, unsigned char base, unsigned |ong *val _ptr)
unsi gned | ong val ue =0;
unsi gned char c¢, hex;
while (*ptr =="' ") ptr++; /[* Skip |eading spaces */
hex = (base == 16);
if (*ptr == 0) return O;
/* _________________________________________________________________ */
/* If hex, allow leading $ or Ox. */
/* _________________________________________________________________ */
i f (hex)
{
if (*ptr =="'9%")
ptr++;
else if ((*ptr =="'0") && ((ptr[1] == "'x") || (ptr[l] = "X)))
ptr = ptr + 2;
}
/* ________________________________________________________________ */

/* Run through the string

addi ng the val ue represented by each */

/* character to the total. */
/* ________________________________________________________________ */
while (*ptr)

{

C = *ptr++;

if ((c >"'0") & (c <="'9"))
C_:IOI;

else if (hex & (¢ >= "A') && (¢ <= "F'))
c=c-"A + 10;

else if (hex & (c >= 'a') && (c <= "1'))

c=c- 'a + 10;
el se
{
Print("Invalid nunber\a\n");
return O;
}
i f (hex)
value = (value << 4) + c;
el se
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<Clib.c> (Continued)
value = value * 10 + c;
}

*val _ptr = val ue;

return 1;

/1 [ Print characters...]

| Function : void put_char(char)

| Description : Transnmit one byte through UART..

voi d put _char (char ch)

{

/1 Wait until UART Trasmit buffer register is enpty...

/1 when enpty, transmt new data
Wait Xm tter(rUSSR);
rTBR = ch;

| Function : void put_string(char*)

| Description : Transmit a string through UART..

void put_string(char *ptr )

{
while(*ptr ) put_char(*ptr++ );
}
| o o o e e o e e e e e e e ieieaoo.

Description : Qutput a character

*
| Function : static void putb(unsigned char ch)
|
| Input : character to output

static void putb(unsigned char ch)

{
Seri al Pol | Conout (ch);
if (ch =="\n")
Seri al Pol | Conout ("\r");
}

$ ———
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<Clib.c> (Continued)

| Function : static unsigned char isdigit(char c)

Description : Determne whether a character is an ASCI | decinma

|
| Input : character to check
| Returns : TRUE if "c" is a decimal digit

static unsigned char isdigit(char c)

{
return (c >='0") && (c <= "'9");
}
| o o e o e e e e e e emeeeeeoo-.
Function : static void charout (FORVAT *f_flags, va_list *arg_pt)

Input : f_flags = ptr to format data structure

*

|

| Description : Qutput a character

|

| arg pt = ptr to next argunent in |ist

static void charout (FORVAT *f_flags, va_list *arg_pt)
{

unsi gned char cbuf[2];

cbuf[0] = (unsigned char) va_arg((*arg_pt), unsigned |ong);
strout (f_flags, cbuf, 1);

Description : returns length of a string

*
| Function : static unsigned |long strlen(unsigned char *str)
|
| Input : str = ptr to string being neasured

static unsigned long strlen(unsigned char *str)

{
long i;
for(i = 0; *str++; i++);
return i;

}

_______ * ]

digit|
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| Function : static void stringout( FORVMAT *f flags, va list *arg_pt)
| Description : Qutput a string

| Input : f_flags = ptr to format data structure

| arg pt = ptr to next argunent in |ist

| Note : Strings |longer than 100 bytes are truncated!

$ ———— —

static void stringout( FORMAT *f_flags, va_list *arg_pt)
{

unsi gned char *str, str_buff[102];

unsi gned char *pt;

unsi gned |l ong str_|en;

pt = &str_buff[101];

str = (unsigned char *)va_arg((*arg_pt), int);

str_len = strlen(str);

if (str_len > f flags->precision & f_flags->precision != 0)
str_len = f_fl ags->precision

if (str_len > 100) str_len = 100;

*(pt) :l\ou;
pt = pt - str_len;
copy(pt, str, str_len);

strout(f_flags, pt, strlen(pt));

*
| Function : static void decout (FORVMAT *f flags, va list *arg pt) |
| Description : Qutput a value as a deci mal nunber
| Input : f_flags = ptr to format data structure
| arg_pt = ptr to next argunment in |ist

*

static void decout (FORMAT *f flags, va_ list *arg_pt)
{

unsi gned char dec_buff[20], *pt, neg;

long val, s_length;

unsi gned long t_count;

t _count = O;
pt = &dec_buff[19];
neg = FALSE

/* Get the value to output fromthe argunment |ist. */
/* _____________________________________________________________________ */
if (f_flags->nmod == "h'")

val = (short) va_ arg((*arg_pt), long);
el se

val = (long) va_arg((*arg_pt), long);
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<Clib.c> (Continued)

/* _____________________________________________________________________ */
/* Null terminate the output string. Not included in output count. */
/* _____________________________________________________________________ */
*(pt--) ="\0";
/* _____________________________________________________________________ */
/* 1If val is negative, set the true flag and nultiply by -1. */
/* _____________________________________________________________________ */
if (val < 0)
{

neg = LTRUE

val = -val;
}
/* _____________________________________________________________________ */
/* While val is greater than zero, output characters to the string */
/* fromright to left. */
/* _____________________________________________________________________ */
do
{

long i, tnp;

/* _________________________________________________________________ */

/* The next two statenents cause problens on the 68000, since that */
/* processor does not have a 32-bit divide instruction. They are */
/* replaced by functionally equival ent routines. */

[* *(pt--) =val %10 + '0"; */

while (tnmp >= 10000) tnp -= 10000;
while (tmp >= 1000) tnp -= 1000;
while (tnp >= 100) tnp -= 100;

while ((tnp -= 10) >= 10);
if (tnp < 0) tnmp += 10;
*(pt--) = (unsigned char)(tnp + '0");

/* val /= (short)10; */

if (val >= 10)

{
for (i = 0; val >= 100000; i += 10000) val -= 100000;
for ( : val >= 10000; i += 1000) val -= 10000
for ( : val >= 1000; i += 100) val -= 1000
for ( ; val >= 100; i += 10) val -= 100;
for ( ; val >= 10; i++) val -= 10
val = i;

}

el se
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val = 0;

t _count ++;
} while (val !'= 0);
while (t_count < f_flags->precision)
{

*(pt--) ="0";

t _count ++;
}
/* ____________________________________________________________________ */
/* Next check to see if the O flag was used in the format and if the */
/* current count is less than the specified field width. |If TRUE then */
[* fill in the leading zeros. Tenporarily leave roomin the field for */
/* an optional plus or mnus sign. */
/* ____________________________________________________________________ */
pt ++;
if (f_flags->zero)
{

s length = strlen(pt);

while (f_flags->width > s_length + 1)

{

*(--pt) =0,
s_length += 1;

}
}
/* ____________________________________________________________________ */
/* Add | eading plus or minus sign, and/or |eading zero if needed. */
/* ____________________________________________________________________ */
if (neg)

“(--pt) ="-",

else if (f_flags->plus)

*(--pt) ="+

else if (f_flags->space)

*(--pt) =" ",

else if ((f_flags->zero) && (f_flags->width > s_|length))

*(--pt) ='0";

f_flags->precision = DEFAULT;
strout(f_flags, pt, strlen(pt));
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<Clib.c> (Continued)

Function : static void hexout (FORVAT *f_flags, va_list
Description : Qutput a value as a hexadeci nal nunber

Input : f_flags = ptr to format data structure
arg_pt = ptr to next argunment in |ist

static void hexout (FORVAT *f_flags, va_list *arg_pt)

{

unsi gned char ¢, *pt, d[16], hexbuff[16];
unsi gned long val, t_count;

I ong s_Il ength;

unsi gned short i;

t _count = O;

/* _____________________________________________________________________ */
/* Set up the array of hex digits used in conversion */
/* _____________________________________________________________________ */
for (i =0; i <=9; i++)

dii] ='0 +1i;
c = (f_flags->type == 'X) ?2 "A : 'a';
for (i = 10; i <= 15; i++)

d[i] = c++
/* _____________________________________________________________________ */
/* Obtain the value to be output. */
/* _____________________________________________________________________ */
if (f _flags->md == 'h')

val = (unsigned short) va arg((*arg_pt), unsigned |ong);
el se

val = (unsigned long) va_ arg((*arg_pt), unsigned |ong);
/* _____________________________________________________________________ */
/* Null ternminate string then process the val ue. */
/* _____________________________________________________________________ */
pt = &hexbuff[15];
*(pt--) ="'\0";
/* _____________________________________________________________________ */
/* Process the val ue */
/* _____________________________________________________________________ */
do
{

*(pt--) = d[val & Oxf];

t _count ++;
} while (val >>= 4);
while (t_count < f_flags->precision)
{

“(pt--) ='0";

t _count ++;
}
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/* _____________________________________________________________________ */
/* Next check to see if the O flag was used in the format and if the */

/* current count is less than the specified field w dth.

If TRUE then */

[* fill in the leading zeros. Tenporarily leave roomin the field for */
/* an optional plus or mnus sign. */
/* _____________________________________________________________________ */
pt ++;
if (f_flags->zero)
{
s length = strlen(pt);
if (f_flags->alter)
while (f_flags->width > s_| ength+2)
{
“(--pt) ='0";
s_length += 1;
}
el se
while (f_flags->width > s_| ength)
{
*(--pt) =0
s_length += 1;
}
}
/* _____________________________________________________________________ */
/* 1If the "alternate fornl' flag is set, add Ox or OX to the front of */
/* the string. */
/* _____________________________________________________________________ */
if (f_flags->alter)
if (f_flags->type == 'x")
“(--pt) ='x";
el se
“(--pt) =X,
“(--pt) ='0";

}

f_flags->precision = DEFAULT;
strout(f_flags, pt, strlen(pt));
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2
| Function : static void strout (FORVAT *f_flags, unsigned char *str, long len)]
| Description : Qutput a formatted string, adding fill characters and
| field justification.
| Input : f_flags = ptr to format data structure
| str = ptr to string
| len = length of string |
_____________________________________________________________________________ * [

static void strout (FORMAT *f_flags, unsigned char *str, long |en)

{

| ong si ze;
unsi gned long i, count = O;
unsi gned char pad ="' ';
/* _____________________________________________________________________ */
/* Check for a NULL string. */
/* _____________________________________________________________________ */
if (len == 0)
str = (unsigned char *)"(null)";
/* _____________________________________________________________________ */
/* Calculate the field w dth. */
/* _____________________________________________________________________ */
f _flags->count += len;
size = (f_flags->width <len ) ? len : f_flags->w dth;
/* _____________________________________________________________________ */
[* If the right justified field is set, fill the |eading characters */
/* with bl anks. */
/* _____________________________________________________________________ */
if (f_flags->right)
{
for (i =size - len; i >0; i--)
{
put b(pad);
count ++;
}
size = len;
}
/* _____________________________________________________________________ */
/* Qutput the string. */
/* _____________________________________________________________________ */
while (*str !'="'\0" & len > 0)
{
put b(*str++);
| en--;
si ze--;
}
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igned long Print(char *format, ...)

| o o e e o o o e e e e e e e em e eeaao oo
[* If left justified, it may be necessary to pad end of the string.
| o o o e o o e e e e e e emeeeeaao o
for (i =size - len; i >0; i--)
{

put b( pad) ;

count ++;
}

f_flags->count += count;

Function : unsigned long Print(char *format, ...)
Description : Format output and send it to the console
Input : format = ptr to format string
additional inputs as specified by *fornat.
Returns : # of characters output
Notes : Format strings are explained in the header at the
top of this nodule.

unsi gned long i p_addr, ch
FORMVAT f _f1l ags;

BUFFER buf ;

va list arg_pt;

buf . buff;
&buf . buf f [ BUFFSI ZE- 1] ;

buf. ptr
buf . end

va start(arg_pt, format);

f_flags.count = O;
if (format == NULL)
format = (char *)"(null)";

2
/* Process characters in 'format ' string until null termnator
/* reached. |If the character is not a '% then sinply print
/[* Otherwise it will require further processing.
2
while (*format = "'\0")
{

if (*format !'="%)

{

put b(*f or mat ++) ;
f _fl ags. count ++;

}

el se

{

$—_———————

it.

*/
*/
*/
*/
*/
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/* _____________________________________________________________ */
/* Set up the fields in the format structure. */
/* _____________________________________________________________ */
f or mat ++;
format = percent(format, & flags, &arg pt);
/* _____________________________________________________________ */
/* Continue to process based on the format type: */
[* d,i - si gned deci nal */
/* x, X - unsi gned hexadeci mal */
/* ¢ - print |east significant character of int */
/* s - argunent taken to be (char *) pointer to string */
I* % - A %is printed. No argunment is converted. */
[* | - | P address (dd.dd. dd. dd) */
/* _____________________________________________________________ */
switch (f_flags.type)
{
case 'd':
case 'i':
decout (& flags, &arg pt);
br eak;
case 'Xx':
case 'X:
hexout (& flags, &arg pt);
br eak;
case 'c':
charout (& flags, &arg_pt);
br eak;
case 's':
stringout (& flags, &arg_pt);
br eak;
case '%:
putb(’ %) ;
f_flags. count ++;
br eak;
case '|':
i p_addr = va_arg((arg_pt), long);
Print("%. %l. %l. %", (ip_addr >> 24) & OxFF,
(i p_addr >> 16) & OxFF,
(ip_addr >> 8) & OxFF,
i p_addr & OxFF);
br eak;
defaul t:
ch = ch;
br eak;
}
}
}
return f_flags. count;
}
7-50 PRELIMINARY VERSION 1.0 ELECTRONICS



KS17C4000 PROGRAMMER'S GUIDE

BOOT ROM PROGRAM EXAMPLES

<Clib.c> (Continued)

| Function :static char *percent(char *format, FORMAT *f flags, va list

| Description : Interpret a conversion specification

| Input : format ptr to current position in format string
| arg_pt = ptr to next argunent
|
|

Returns : Ptr to next char in format string past this specifier
Qutputs : *f flags = filled in with format specificatio

static char *percent(char *format, FORVAT *f_flags, va_list *arg_pt)

{
unsi gned char p_flag = FALSE

f_flags->w dth = DEFAULT;
f_flags->precision = DEFAULT_P
f_flags->right = LTRUE
f_flags->plus = FALSE
f_flags->alter = FALSE
f_flags->zero = FALSE
f_flags->space = FALSE
f_flags->type = '"\0';
f_flags->nod = '"\0';

2
/* Process the flags that may exists between the '% and the start of

/* the width specification. The follow ng flags may exist:

/*
/* e to set left justified
/* "t result will always have sign (+ or -)
/* space for |eading space
/* "# for alternate form
/* o) use | eadi ng zeros instead of spaces.
/*
/* The sequence of these flags is inportant.
2
if (*format == "'-")
{
f _flags->right = FALSE

f or mat ++;

}
if (*format == "'+")

{

f_flags->plus = LTRUE

f or mat ++;
}
if (*format == "' ")
{

if (f_flags->plus == FALSE)

R

*/
*/
*/
*/
*/
*/
*/
*/
*/
*/

R
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f _flags->space = LTRUE;

f or mat ++;
}
if (*format == "#")
{
f_flags->alter = LTRUE;
f or mat ++;
}
if (*format == '0")
{
if (f_flags->right)
f _flags->zero = LTRUE;
f or mat ++;
}
/* _____________________________________________________________________ */
/* Process the width specification of the format. The wi dth can be */
/* specified by the next value in the arg pt list. |[If the next */
/* character is '*' then get the width fromarg_pt with a call to the */
/* va_arg() macro. */
/* */
/* The width can al so be specified as a value in the fornmat. In this */
/* case the width is specified by a deci mal nunber. */
/* _____________________________________________________________________ */
if (*format == "'*")
{
f flags->width = va_arg((*arg _pt), int);
if (f _flags->width < 0)
{
f _flags->right = FALSE;
f_flags->width = -f_fl ags->w dt h;
}
f or mat ++;
}
el se
{
if (isdigit(*format))
for (f _flags->width = 0; isdigit(*format); )
f_flags->width = f_flags->width * 10 + *format++ - '0';
}
/* _____________________________________________________________________ */
/* Process the precision field. The sane options that are allowed for */
/* the width field are permitted here. */
/* _____________________________________________________________________ */
if (*format == "'.")
{

p_flag = LTRUE;
f or mat ++;
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if (*format == '*")
{
f flags->precision = va_arg((*arg _pt), int);
f or mat ++;
}
el se
f_flags->precision = 0;
while (isdigit (*format))
f_flags->precision = f_flags->precision * 10 + *format++ - '0';
}
}
/* _____________________________________________________________________ */
/* Check for process nodifier characters. {h, |, L} */
/* _____________________________________________________________________ */
if ((*format == 'h'") || (*format =="1") || (*format == 'L"))
f _flags->nod = *fornat ++;
/* _____________________________________________________________________ */
/* Based on the type of conversion it nmay be necessary to readjust the */
/* precision flag to a default val ue of O. */
/* _____________________________________________________________________ */
if ((p_flag == FALSE) && (*format !="'c¢c') && (*format !="'%))
f _flags->precision = 0;
/* _____________________________________________________________________ */
/* The final step is to read in the conversion type. */
/* _____________________________________________________________________ */

f_flags->type = *format ++;
return format;
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KS17C4000 PROGRAMMER'S GUIDE

FUNCTION MAIN( ): <Main.c>

I

Il KS17C4000 Denmo Program

I

//; File: Main.c

I

/1; Date: 1999.04.01

I

[1; Author: Jinwook Jang E-nmil: newredi a@ansung. co. kr

I

I

#i ncl ude "..\ks17c4000. h"

#i ncl ude "..\arnstdio.h"

#i ncl ude "..\exception.h"

#i ncl ude "adc. h"

#i ncl ude "btwdt. h"

#i ncl ude "cache. h"

#i ncl ude "dma. h"

#i ncl ude "down. h"

#i ncl ude "iop.h"

#i ncl ude "isr.h"

#i ncl ude "menory. h"

#i ncl ude "sio.h"

#i ncl ude "sysmgr. h"

#i ncl ude “tinmer.h"

#i ncl ude "uart.h"

/* ________________________________________________________________ *
| Functi on voi d I nitBd(void)
| Description : Initialize for Conmand Line Interface |
K o o o e o o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e et */

voi d I nitBd(void)

{

r SYSCON | = (0x3<<3);
ArintStatus();
UARTPol I I nit();

/1 CPU dock = Xin/1
/1 rI NTPEND=0, r|NTMASK=0, r| NTMODE=0
/1 Polling Mode UART initialize
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<Main.c> (Continued)

/* ________________________________________________________________ *
| Functi on : void Main(void) |
| Description : C Program Entry Poi nt |
K o o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e */

voi d Mai n(voi d)

{

I ni t Exceptions();
I nitBd(); [/TINT X/ UART POLLI NG MODE
Port _Init();
/1
Write Supplement Program here...
/1
}
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